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Product notice
This guide describes features that are
common to most models. Some features may
not be available on your computer. Not all
features are available in all editions of
Windows 8.
This computer may require upgraded and/
or separately purchased hardware, drivers,
and/or software to take full advantage of
Windows 8 functionality. See
http://www.microsoft.com for details.
Software terms
By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to
be bound by the terms of the HP End User
License Agreement (EULA). If you do not
accept these license terms, your sole remedy
is to return the entire unused product
(hardware and software) within 14 days for
a refund subject to the refund policy of your
place of purchase.
For any further information or to request a
full refund of the computer, please contact
your local point of sale (the seller).

Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

Product Name

HP EliteBook 8570w Mobile Workstation

Processors

Intel® Core™ processors
Intel Quad Core i7-3840QM 2.80-GHz processor (SC turbo up to 3.80GHz; 1600-MHz FSB, 8.0-MB L3 cache, 45 W)
i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), quad-core processor,
1600 MHz, 8 MB L3 Cache, 8 threads, 45W
Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W)
i7-3720QM, 2.60GHz (Turbo up to 3.60 GHz), quad-core processor,
1600 MHz, 6 MB L3 Cache, 8 threads, 45W
Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40GHz; 1600-MHz FSB, 6.0-MB L3 cache, 45 W)
i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), quad-core processor
1600 MHz, 6MB L3 Cache, 8 threads, 45W
i7-3520M, 2.90GHz (Turbo up to 3.60 GHz), dual–core processor, 1600
MHz, 4MB L3 Cache, 4 threads, 35W
i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), dual-core processor, 1600
MHz, 3 MB L3 Cache, 4 threads, 35W
i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), dual-core processor, 1600
MHz, 3 MB L3 Cache, 4 threads, 35W

Chipset

Mobile Intel QM77 chipset

Graphics

Models feature the following graphics subsystem boards, supporting:
●

Open GL

●

Display Port 1.2

●

Up to four total displays (NVIDIA)

●

Up to five total displays (AMD)

NVIDIA® Quadro® K2000M (NVIDIA N14P-Q3 2GB DDR3)
NVIDIA Quadro K1000M (NVIDIA N14P-Q1 2GB DDR3)
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Category

Description

Graphics (continued)

AMD FirePro™ M4000 (Chelsea XT GL 1GB GDDR5)

Display

Display panel:
●

Supports privacy filter

●

Wedge design

39.6 cm (15.6 in) High-Definition Plus (HD+) AntiGlare (AG) LED WVA
(1600 x 900 resolution, 200nits, 60%CG)
39.6 cm (15.6 in) FHD AG LED WVA (1920 x 1080 resolution, 220 nits,
60% CG)
Display assembly (DreamColor):
●

Supports privacy filter

●

Includes display panel cable, 3 WLAN antenna and cables, and 2
WWAN antenna and cables

●

Not available with HP Mobile Broadband

39.6 cm (15.6 in) FHD AG RGB LED UWVA Dream Color (1920 x 1080
resolution, 210 nits, 109% CG)
39.6 cm (15.6 in) FHD AG RGB LED UWVA Dream Color with webcam
(1920 x 1080 resolution, 210 nits, 109% CG)
Memory

In models that use quad-core processors, four SODIMM customeraccessible/upgradeable memory module slots supporting up to 32 GB
of RAM
In models that use dual-core processors, two SODIMM customer-accessible/
upgradeable memory module slots supporting up to 16 GB of RAM
PC3-12800, 1600-MHz, DDR3
Supports dual-channel memory
Supports the following configurations:
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●

2048 MB Total System Memory (2048 x 1)

●

4096 MB Total System Memory (4096 x 1)

●

4096 MB Total System Memory (2048 x 2)

●

8192 MB Total System Memory (8192 x 1)

●

8192 MB Total System Memory (4096 x 2)

●

8192 MB Total System Memory (2048 x 4) — only available with
quad-core processors

●

16384 MB Total System Memory (8192 x 2)

●

16384 MB Total System Memory (4096 x 4) — only available with
quad-core processors

●

32768 MB Total System Memory (8192 x 4) — only available with
quad-core processors

Category

Description

Primary location hard drive

Customer-accessible
Supports RAID 0/1
Supports the following 7.0 mm, 9.5-mm SATA hard drives (6.35 cm
(2.50 in) )
●

750 GB, 7200 rpm

●

500 GB, 7200 rpm

●

500 GB, 7200 rpm Self Encrypting Drive

●

320 GB, 7200 rpm

Supports the following 6.35 cm (2.5 in) SATA III solid-state drives:

Upgrade bay

●

256 GB Self Encrypting Drive

●

180 GB

●

160 GB

●

128 GB

Fixed
Customer-accessible
Serial ATA
Supports 500 GB, 7200 rpm drive and 256 GB SSD Self Encrypting Drive
Supports the following 12.7 mm tray load optical drives:
●

DVD-ROM Drive

●

DVD±RW and CD-RW SuperMulti Double Layer (DL) Drive

●

Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive

●

Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive

Supports “No Drive” option
Microphone

Integrated dual-array microphone

Audio

HD Audio w/ SRS Premium Sound
Stereo speakers (2)

Webcam

Integrated webcam (720p HD)

Modem

56K V.92 MDC data/fax modem
Modem cable not included
Supports “No Modem” option

Ethernet

Intel 82579LM 10/100/1000 network interface card (NIC), with iAMT
S3/S4/S5 wake on LAN
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Category

Description

Ethernet (continued)

NIC power down technology
Ethernet cable not included

Wireless

Integrated WLAN options by way of wireless module:
●

Broadcom 43228 802.11 a/b/g/n Wi-Fi 2×2 Adapter

●

Intel Centrino Advanced N 6205 802.11 a/b/g/n 2×2 WiFi Adapter

●

Intel Centrino Advanced-N 6205 Combo Adapter

●

Intel Centrino Ultimate-N 6300 802.11 a/b/g/n 3×3 WiFi Adapter

●

Intel Centrino Ultimate-N 6300 Combo Adapter

Three WLAN antennas built into display assembly
Supports “no WLAN” option
Integrated WWAN options by way of wireless module:
●

HP hs2350 HSPA+ Mobile Broadband Module

●

HP lt2523 LTE/HSPA+ Mobile Broadband Module

●

HP lt2522 LTE/EV-DO Mobile Broadband Module

●

HP un2430 EV-DO/HSPA Mini Card

●

HP un2430 EV-DO/HSPA Mobile Broadband Module

Three WWAN antennas built into display assembly
Subscriber identity module (SIM) security (customer-accessible in battery bay)
Supports “no WWAN” option
Integrated personal area network (PAN) options by way of
Bluetooth® module:
HP Integrated Module with Bluetooth 2.1 Wireless Technology
Supports “no WPAN” option
External media card

One ExpressCard/54 slot
Integrated Media Card Reader supports Secure Digital Card (SD), SD High
Capacity (SDHC), SD eXtended-Capacity (SDXC), MultiMediaCard (MMC),
and MMCplus (MMC+) formats

Ports

Audio-in (stereo microphone)
Audio-out (stereo headphone)
DisplayPort 1.2
RJ-11 (modem)
RJ-45 (Ethernet, includes link and activity lights)
USB 3.0 (2)
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Category

Description

Ports (continued)

USB 2.0 (2) (1 charging port)
eSATA/USB 2.0 combo
VGA (Dsub 15-pin)
1394a
Headphone Output (stereo)
Docking connector
Multi-pin AC

Docking

HP Docking Station
HP Advanced Docking Station

Keyboard/pointing devices

Full-size keyboard with separate numeric keypad and TouchPad scroll zone
Backlit full-size keyboard with separate numeric keypad and TouchPad scroll
zone (select models only)
Dual point (pointing stick and TouchPad) with 3 pointing stick buttons, 3
TouchPad buttons, and scroll zone
Spill-resistant design, DuraKey coating
Chemically strengthened glass cover on TouchPad
Taps and gestures enabled by default: 2-finger scrolling, 2-finger
zoom (pinch)
Four launch buttons (Browser, wireless on/off, calculator, and mute volume)

Power requirements

AC adapter with localized cable plug support (3-wire plug with ground pin,
supports 3-pin DC connector):
●

200W SLIM Smart AC Adapter

●

150W SLIM Smart AC Adapter

●

120W SLIM Smart AC Adapter

8-cell 2.8 Ah (83 Wh) Li-ion battery
8-cell 2.8 Ah (75 Wh) Li-ion battery (1000 cycle 3 yr. warranty)
Support for 9-cell (73 Wh) polymer HP ST09 Extended Life Battery (does not
support HP Fast Charge)
Support for 9-cell (100 Wh) cylindrical HP BB09 Ultra-Capacity Extended
Life Battery (does not support HP Fast Charge)
HP Fast Charge Technology
Security

Integrated fingerprint reader
Full volume encryption
Integrated smart card reader
Security cable slot
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Category

Description

Security (continued)

Trusted Platform Module (TPM) V.1.2
Preboot authentication (password, smart card)

Operating system

Preinstalled:
●

Windows 8 Professional 64 with Microsoft Basics (Canada, Japan,
and the United States only)

●

Windows 8 Professional 64 DPK with Windows 7 Professional 64 and
32 (Canada, Japan, and the United States only)

●

Windows 7 Home Premium 64 and 32 with Microsoft Basics (Asia/
Pacific, Europe, and the United States only)

●

Windows 7 Professional 64 and 32 with Microsoft Basics (Canada,
Japan, and the United States only)

●

Windows 7 Service Pack 1

●

FreeDOS (world-wide)

Preinstalled with Microsoft Office:
●

Windows 8 Professional 64 with Microsoft Office 2010 Transitional
DPK (not supported in Japan)

●

Windows 8 Professional 64 DPK with Windows 7 Professional 64 and
32 image with Microsoft Office 2010 Starter (not supported in Asia/
Pacific, Japan, and the People's Republic of China)

●

Windows 7 Professional 64 and 32 with Microsoft Office 2010 Starter
(not supported in Japan)

Restore media—DRDVD:
●

Windows 8 (available with any Windows 8 loc, required with any
Windows 7 Professional downgrade OS)

●

Windows 7 (available with any Windows 7 or Windows 7
Professional downgrade loc)

●

Red Hat Enterprise Linux (RHEL) 6.x 64-bit (available with FreeDOS
and all Windows OS; available on the Web as an ISO)

●

SuSE Linux Enterprise (SLED) Service Pack 2 64-bit (available with
FreeDOS and all Windows OS; available on the Web as an ISO)

Restore media—OSDVD:
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●

Windows 8 Professional 64 (available only and required with
Windows 7 Professional downgrade OS)

●

Windows 7 Home Premium 64 (available with Windows 7 Home
Premium loc; not supported in Asia/Pacific or the People's Republic
of China)

●

Windows 7 Professional 64 and 32 (available with any Windows 7
Professional or Windows 7 Professional downgrade loc.; not supported
in Asia/Pacific or the People's Republic of China)

Category

Description

Operating system (continued)

Certified:
●

Microsoft WHQL

●

Red Hat Enterprise Linux (RHEL) 6.x 64-bit

●

SuSE Linux Enterprise (SLED) Service Pack 2 64-bit

Web-only support:

Serviceability

●

Windows 8 Professional 32

●

Windows 7 Enterprise 64 and 32

●

Windows 7 Ultimate 64 and 32

●

Windows XP Professional 64 and 32

●

Red Hat Enterprise Linux (RHEL) 6.x 64-bit (closed-source drivers/
restore media (DRDVD ISO)

●

SuSE Linux Enterprise (SLED) Service Pack 2 64-bit (closed-source
drivers/restore media (DRDVD ISO)

End-user replaceable parts:
AC adapter
Battery (system)
Hard drive/SSD
Memory module
Optical drive
Mini-PCI components (WLAN, WWAN, SIM)
Keyboard
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External Component Identification

Top
TouchPad

Component
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Description

(1)

Left pointing stick button

Functions like the left button on an external mouse.

(2)

Center pointing stick button

Functions like the center button on an external mouse.

(3)

Pointing stick

Moves the pointer and selects or activates items on the
screen.

(4)

Right pointing stick button

Functions like the right button on an external mouse.

(5)

Right TouchPad button

Functions like the right button on an external mouse.

(6)

Center TouchPad button

Functions like the center button on an external mouse.

(7)

Left TouchPad button

Functions like the left button on an external mouse.

Chapter 2 External Component Identification

Component

Description

(8)

TouchPad zone

Moves the pointer and selects or activates items on the
screen.

(9)

TouchPad on/off button

Turns the TouchPad on and off when it is double-tapped.

Top
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Lights

Component
(1)

TouchPad light

●

Amber: The TouchPad is off.

●

Off: The TouchPad is on.

(2)

Caps lock light

On: Caps lock is on.

(3)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

(4)

Num lk light

On: Num lk is on.

(5)

Wireless light

●

White: An integrated wireless device, such as a wireless
local area network (WLAN) device and/or a
Bluetooth® device, is on.

●

Amber: All wireless devices are off.

●

Amber: Computer sound is off.

●

Off: Computer sound is on.

●

On: The computer is on.

●

Off: The computer is off or in Hibernation.

●

On: The calculator function is on.

●

Blinking: The calculator has been activated.

(6)

(7)

(8)
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Description

Mute light

Web browser light

Calculator light
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Buttons and fingerprint reader (select models only)

Component
(1)

Description
Power button

●

When the computer is off, press the button to turn on the
computer.

●

When the computer is on, press the button briefly to
initiate Sleep.

●

When the computer is in the Sleep state, press the
button briefly to exit Sleep.

●

When the computer is in Hibernation, press the button
briefly to exit Hibernation.

CAUTION: Pressing and holding down the power button
will result in the loss of unsaved information.
If the computer has stopped responding and Microsoft®
Windows® shutdown procedures are ineffective, press and
hold the power button for at least 5 seconds to turn off the
computer.
To learn more about your power settings:

(2)

Wireless button

●

Windows 8—From the Start screen, type power, select
Settings, and then select Power Options.

●

Windows 7—Select Start > Control Panel >
System and Security > Power Options. For more
information, see the HP Notebook Reference Guide.

Turns the wireless feature on or off but does not establish a
wireless connection.

Top
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Component
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Description

(3)

Volume mute button

Mutes and restores speaker sound.

(4)

Web browser button

When Windows is running, press the button to open the
default Web browser.

(5)

Calculator button

Activates the calculator function.

(6)

Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a
password logon.

(7)

TouchPad on/off button

Turns the TouchPad on and off when it is double-tapped.
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Keys

Component

Description

(1)

esc key

Displays system information when pressed in combination
with the fn key.

(2)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key. .
NOTE:

fn12 is for models with backlit keyboards.

(3)

fn key

Executes frequently used system functions when pressed in
combination with a function key, the num lk key, the esc key,
or other keys.

(4)

Windows logo key

Displays the Windows Start menu.

(5)

Windows applications key

Displays a shortcut menu for items beneath the cursor.

(6)

Integrated numeric keypad

When num lk has been enabled, it can be used like an
external numeric keypad. To alternate between this numeric
function and the navigational function (indicated by the
directional arrows on the keys), press the num lk key.

(7)

num lk key

Alternates between the navigational and numeric functions
on the integrated numeric keypad.

Top
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Front

Component

Description

(1)

Wireless light

Turns the wireless feature on or off but does not
establish a wireless connection.

(2)

Power light

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

Amber: The computer is connected to external
power and the battery is charged from 0 to 90
percent.

●

White: The computer is connected to external
power and the battery is charged from 90 to 99
percent.

●

Blinking amber: A battery that is the only available
power source has reached a low battery level.
When the battery reaches a critical battery level,
the battery light begins blinking rapidly.

●

Off: The battery is fully charged.

●

Blinking white: The hard drive is being accessed.

●

Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(3)

(4)

AC adapter/Battery light

Hard drive light

NOTE: For information on HP 3D DriveGuard,
see the HP Notebook Reference Guide.
(5)
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Display release latch

Chapter 2 External Component Identification

Opens the computer.

Component
(6)

(7)

Description
Media Card Reader

Speakers (2)

Supports the following digital card formats:
●

MultiMediaCard

●

MultiMediaCardplus (MMC+)

●

Secure Digital (SD) Card

●

Secure Digital HC (SDHC) Card

●

Secure Digital XC (SDXC) Card

Produce SRS Premium Sound (select models only).
NOTE:

To use the SRS Premium Sound software:

●

Windows 8—From the Start screen, type SRS, and
then select SRS Premium Sound.

●

Windows 7—Select Start > All Programs >
SRS Premium Sound.

Front
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Right

Component
(1)

Description
Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, earbuds, a headset, or television
audio.
WARNING! To reduce the risk of personal injury, adjust
the volume before putting on headphones, earbuds, or a
headset. For additional safety information, see the
Regulatory, Safety, and Environmental Notices.
NOTE: When a device is connected to the jack, the
computer speakers are disabled.

(2)

Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(3)

USB 3.0 ports (2)

Connect optional USB 3.0 compatible devices and provide
enhanced USB power performance.

(4)

External monitor port

Connects an external VGA monitor or projector.

(5)

Smart card reader

Supports optional smart cards.

(6)

Upgrade bay (optical drive shown)

The upgrade bay can hold a protective insert, a hard drive,
or an optical drive that reads an optical disc.
NOTE: On select models, the optical drive also writes to
an optical disc.

(7)
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Optical drive eject button (select models
only)
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Releases the disc tray.

Left

Component
(1)

Description
Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.

(2)

RJ-45 (network) jack

Connects a network cable.

(3)

Vents (2)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(4)

DisplayPort

Connects an optional digital display device, such as a highperformance monitor or projector.

(5)

eSATA/USB 2.0 combo port

Connects an optional high-performance eSATA component,
such as an eSATA external hard drive, or connects an
optional USB device.

(6)

USB 2.0 port

Connects an optional USB device. For more information
about USB devices, see the HP Notebook Reference Guide.

(7)

USB charging port

Connects an optional USB 2.0 compatible device

(8)

1394 port

Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(9)

HP ExpressCard slot

Supports optional ExpressCards.

Left
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Rear

Component
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Description

(1)

RJ-11 (modem) jack

Connects a modem cable.

(2)

Power connector

Connects an AC adapter.
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Display

Component

Description

(1)

Turns off the display or initiates Sleep if the display is closed
while the power is on.

Internal display switch

NOTE: The display switch is not visible from the outside of the
computer.
(2)

WLAN antennas (3)*

Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

(3)

WWAN antennas (2)*

Send and receive wireless signals to communicate with wireless
wide area networks (WWAN).

(4)

Internal microphones (2)

Record sound.

(5)

Webcam light (select models only)

On: The webcam is in use.

(6)

Webcam (select models only)

Records video and captures still photographs.
To use the webcam:
●

Windows 8—From the Start screen, type h, and then select
Help and Support.

●

Windows 7—Select Start > All Programs >
Communication and Chat > HP Webcam.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region. These notices are located in Help and Support.

Display
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Bottom

Component

Description

(1)

Battery bay

Holds the battery.

(2)

SIM slot

Supports a wireless subscriber identity module (SIM).
The SIM slot is located inside the battery bay.

(3)

Battery release latch

Releases the battery.

(4)

Accessory battery connector

Connects an optional accessory battery.

(5)

Docking connector

Connects an optional docking device.

(6)

Service door release latch

Releases the service door from the computer.

(7)

Vents (4)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to
cool internal components and prevent overheating. It
is normal for the internal fan to cycle on and off
during routine operation.

20

Chapter 2 External Component Identification

Component

Description

(8)

Bluetooth compartment

Contains a Bluetooth device (select models only).

(9)

Service door

Provides access to the hard drive, the wireless LAN
(WLAN) module slot, the WWAN module slot, and
the memory module slots.
CAUTION: To prevent an unresponsive system,
replace the wireless module only with a wireless
module authorized for use in the computer by the
governmental agency that regulates wireless devices
in your country or region. If you replace the module
and then receive a warning message, remove the
module to restore computer functionality, and then
contact technical support through Help and Support.

Bottom
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Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.
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Item

Description

Function

(1)

Product name

The name affixed to the front of the computer.

(2)

Serial number (s/n)

This is an alphanumeric identifier that is unique to
each product.

(3)

Part number/Product number (p/n)

This number provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.

Chapter 3 Illustrated parts catalog

Computer major components

Computer major components
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Item

Description

(1)

39.6-cm (15.6 in) FHD RGB UWVA LCD display assembly with DreamColor

(2)

Spare part
number

For use in computer models without webcams

653277-001

For use in computer models with webcams

653278-001

Keyboard with numeric keypad and pointing stick (includes keyboard cable and pointing stick cable):
Keyboard with backlight for use only on computer models equipped with the Windows 8 operating system (includes
backlight cable):
For use in Belgium

703149-A41

For use in Canada

703149-DB1

For use in the Czech Republic and Slovakia

703149-FL1

For use in Denmark

703149-081

For use in France

703149-051

For use in Germany

703149-041

For use in India

703149-D61

For use in Italy

703149-061

For use in Latin America

703149-161

For use in the Netherlands

703149-B31

For use in Norway

703149-091

For use in Russia

703149-251

For use in South Korea

703149-AD1

For use in Sweden and Finland

703149-B71

For use in Switzerland

703149-BG1

For use in Taiwan

703149-AB1

For use in Thailand

703149-281

For use in the United Kingdom and Singapore

703149-031

For use in the United States

703149-001

Keyboard without backlight for use only on computer models equipped with the Windows 8 operating system:
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For use in Belgium

703151-A41

For use in Brazil

703151-201

For use in Bulgaria

703151-261

For use in Canada

703151-DB1

For use in the Czech Republic and Slovakia

703151-FL1

For use in Denmark

703151-081
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Item

Description

Spare part
number

For use in France

703151-051

For use in Germany

703151-041

For use in Greece

703151-151

For use in Hungary

703151-211

For use in Iceland

703151-DD1

For use in India

703151-D61

For use in Israel

703151-BB1

For use in Italy

703151-061

For use in Japan

703151-291

For use in Latin America

703151-161

For use in the Netherlands

703151-B31

For use in Norway

703151-091

For use in Northwest Africa

703151-FP1

For use in Portugal

703151-131

For use in Romania

703151-271

For use in Russia

703151-251

For use in Saudi Arabia

703151-171

For use in Slovenia

703151-BA1

For use in South Korea

703151-AD1

For use in Spain

703151-071

For use in Sweden and Finland

703151-B71

For use in Switzerland

703151-BG1

For use in Taiwan

703151-AB1

For use in Thailand

703151-281

For use in Turkey

703151-141

For use in the United Kingdom and Singapore

703151-031

For use in the United States

703151-001

Keyboard with backlight for use only on computer models equipped with the Windows 7 operating system (includes
backlight cable):
For use in Belgium

690647-A41

For use in the Canada

690647-DB1

For use in the Czech Republic and Slovakia

690647-FL1

Computer major components
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Item

Description

Spare part
number

For use in Denmark

690647-081

For use in France

690647-051

For use in Germany

690647-041

For use in India

690647-D61

For use in Italy

690647-061

For use in Latin America

690647-161

For use in the Netherlands

690647-B31

For use in Norway

690647-091

For use in Russia

690647-251

For use in South Korea

690647-AD1

For use in Sweden and Finland

690647-B71

For use in Switzerland

690647-BG1

For use in Taiwan

690647-AB1

For use in Thailand

690647-281

For use in the United Kingdom and Singapore

690647-031

For use in the United States

690647-001

Keyboard without backlight for use only on computer models equipped with the Windows 7 operating system:
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For use in Belgium

690648-A41

For use in Brazil

690648-201

For use in Bulgaria

690648-261

For use in Canada

690648-DB1

For use in the Czech Republic and Slovakia

690648-FL1

For use in Denmark

690648-081

For use in France

690648-051

For use in Germany

690648-041

For use in Greece

690648-151

For use in Hungary

690648-211

For use in Iceland

690648-DD1

For use in India

690648-D61

For use in Israel

690648-BB1

For use in Italy

690648-061

For use in Japan

690648-291
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Item

Description

Spare part
number

For use in Latin America

690648-161

For use in the Netherlands

690648-B31

For use in Norway

690648-091

For use in Northwest Africa

690648-FP1

For use in Portugal

690648-131

For use in Romania

690648-271

For use in Russia

690648-251

For use in Saudi Arabia

690648-171

For use in Slovenia

690648-BA1

For use in South Korea

690648-AD1

For use in Spain

690648-071

For use in Sweden and Finland

690648-B71

For use in Switzerland

690648-BG1

For use in Taiwan

690648-AB1

For use in Thailand

690648-281

For use in Turkey

690648-141

For use in the United Kingdom and Singapore

690648-031

For use in the United States

690648-001

(3)

Top cover (includes TouchPad button and bracket)

690645-001

(4)

Power connector (included in the cable kit, spare part number 690623-001. For information about cable kit
contents, see Cable Kit on page 33.)

(5)

RJ-45 (network) jack (included in the cable kit, spare part number 690623-001. For information about cable kit
contents, see Cable Kit on page 33.

(6)

TouchPad button board (included with top cover, spare part number 690645-001)

(7)

Audio/USB 3.0 board

(8)

Fan and heat sink assembly

690636-001

For use in computers with AMD FirePro M4000 graphics cards

690628-001

use in computers with NVIDIA Quadro K2000M graphics cards

690630-001

For use in computers with NVIDIA Quadro K1000M graphics cards

690629-001

(9)

Modem module (56k v.92 MDC data/fax modem)

628824-001

(10)

RJ-11 (modem) jack (included in the cable kit, spare part number 690623-001. For information about cable kit
contents, see Cable Kit on page 33.)

(11)

Processor

Computer major components
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Item

Description

Spare part
number

Intel Quad Core i7-3840QM 2.80-GHz processor (SC turbo up to 3.80-GHz; 1600-MHz
FSB, 8.0-MB L3 cache, 45 W)

703266-002

i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), quad-core processor, 1600 MHz, 8 MB L3
Cache, 8 threads, 45W

681284-002

Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz
FSB, 6.0-MB L3 cache, 45 W)

702840-002

i7-3720QM, 2.60GHz (Turbo up to 3.60 GHz), quad-core processor, 1600 MHz, 6 MB L3
Cache, 8 threads, 45W

681283-002

Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz
FSB, 6.0-MB L3 cache, 45 W)

702081-002

i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), quad-core processor 1600 bMHz, 6MB L3
Cache, 8 threads, 45W

680646-002

i7-3520M, 2.90GHz (Turbo up to 3.60 GHz), dual-core processor, 1600 MHz, 4MB L3
Cache, 4 threads, 35W

681954-002

i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), dual-core processor,1600 MHz, 3 MB L3
Cache, 4 threads, 35W

681953-002

i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), dual-core processor, 1600 MHz, 3 MB L3
Cache, 4 threads, 35W

681952-002

(12)

ExpressCard/USB 2.0 assembly board

684793-001

(13)

Graphics card (includes replacement thermal material)

(14)

(15)
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NVIDIA Quadro K2000M (NVIDIA N14P-Q3 2GB DDR3)

690637-001

NVIDIA Quadro K1000M (NVIDIA N14P-Q1 2GB DDR3)

690638-001

AMD FirePro M4000 (Chelsea XT GL 1GB GDDR5)

690639-001

Memory modules
8 GB (DDR3 1600 MHz PC3-12800)

670034-001

4 GB (DDR3 1600 MHz PC3-12800)

641369-001

2 GB (DDR3 1600 MHz PC3-12800)

652972-001

System board (includes replacement thermal material)
For use with quad-core processors and the Windows 8 Professional operating system in all
countries except China and Russia

690643-601

For use with quad-core processors and the Windows 8 Standard operating system in all
countries except China and Russia

690643-501

For use with quad-core processors and the Windows 7 operating system in all countries
except China and Russia

690643-001

For use with quad-core processors in China and Russia only

696441-001

For use with dual-core processors and the Windows 8 Professional operating system in all
countries except China and Russia

690642-601
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Item

Description

Spare part
number

For use with dual-core processors and the Windows 8 Standard operating system in all
countries except China and Russia

690642-501

For use with dual-core processors and the Windows 7 operating system in all countries
except China and Russia

690642-001

For use with dual-core processors in China and Russia only

696440-001

(16)

VGA port

690640-001

(17)

RTC battery

652650-001

(18)

Speakers

652669-001

(19)

Display hinge cover (includes Hewlett Packard logo)

652657-001

(20)

Battery
8-cell Li-ion 83-Wh battery

632427-001

8-cell Li-ion 75-Wh battery

632425-001

9-cell Li-ion 73-Wh extended life battery

634089-001

9-cell Li-ion 100-Wh ultra-capacity extended life battery

634087-001

(21)

Display latch

652647-001

(22)

Bluetooth module

655792-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the cable kit, spare part number 690623-001. For
information about cable kit contents, see Cable Kit on page 33.
(23)

Base enclosure

(24)

WLAN module

(25)

(26)

698946-001

Broadcom 43228 802.11 a/b/g/n Wi-Fi 2×2 Adapter

669832-001

Intel Centrino Advanced N 6205 802.11 a/b/g/n 2×2 WiFi Adapter

631954-001

Intel Centrino Advanced-N 6205 Combo Adapter

695915-001

Intel Centrino Ultimate-N 6300 802.11 a/b/g/n 3×3 WiFi Adapter

572511-001

Intel Centrino Ultimate-N 6300 Combo Adapter

698588-001

WWAN module
HP hs2350 HSPA+ Mobile Broadband Module

668969-001

HP lt2523 LTE/HSPA+ Mobile Broadband Module

675793-001

HP lt2522 LTE/EV-DO Mobile Broadband Module

710789-001

HP un2430 EV-DO/HSPA Mini Card

702080-001

HP un2430 EV-DO/HSPA Mobile Broadband Module

634400-001

Smart card reader (includes door and cable)

652672-001

Computer major components
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Item

Description

(27)

Hard drive

Spare part
number

750 GB, 7200 rpm

633252-001

500 GB, 7200 rpm

634925-001

500 GB, 7200 rpm , Self Encrypting hard drive (SED)

683801-001

320 GB, 7200 rpm, 7-mm

634862-001

Solid-state drive

(28)

(29)
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256 GB SATA III solid-state drive (SSD) SED

694683-001

180 GB SATA II SSD

694684-001

160 GB SATA II SSD

694685-001

128 GB SATA III SSD

653434-001

128 GB SATA III SSD locked

705053-001

Hard Drive Hardware Kit (includes hard drive bracket and screws)

644694-001

Upgrade bay device
DVD-ROM Drive

694687-001

DVD±RW and CD-RW SuperMulti DL Combo Drive

694688-001

Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive

694689-001

Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive

694690-001

Upgrade bay bezel (not illustrated)

655547-001

Service door (with feet)

652648-001

Cable kit (not illustrated). For information about cable kit contents, see Cable Kit
on page 33.

690623-001

Chapter 3 Illustrated parts catalog

Display components

Item

Description

(1)

Display bezel

Spare part number

For use on computer models with a webcam

690621-001

For use on computer models without a webcam

690622-001

(2)

Display hinges (includes left and right hinges)

652646-001

(3)

39.6-cm (15.6 in) display panel
HD+ WVA display panel

690644-001

FHD WVA display panel

694681-001

(4)

Webcam module

699687-001

(5)

Display cover (included in raw panel support kit, spare part number 690632-001)
HP Logo Kit (not illustrated, includes cables)

(6)

652666-001

Cable routing tray (included with the plastics kit, spare part number 684794-001)
WLAN antennas and cables (not illustrated, included in the cable kit, spare part number 690623-001. For
information about cable kit contents, see Cable Kit on page 33.)
WWAN antennas and cables (not illustrated, included in the cable kit, spare part number 690623-001. For
information about cable kit contents, see Cable Kit on page 33.)

Display components
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Plastics Kit

Item

32

Description

Spare part number

Plastics Kit:

652664-001

(1)

Battery cover

(2)

SD Card blank

(3)

Optical drive weight saver

(4)

Display latch button

(5)

RJ-11 jack cover

(6)

ExpressCard blank

(7)

Inverter cover (2 are included, one for models with DreamColor and one for models without DreamColor)
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Cable Kit

Item

Description

Spare part number

Cable Kit:

690623-001

(1)

WWAN antenna

(2)

WLAN antenna

(3)

Bluetooth module cable

(4)

RJ11 connector cable

(5)

RJ45 connector cable

(6)

Power connector cable

(7)

TouchPad cable

Cable Kit

33

Mass storage devices

Item

Description

(1)

Optical drive

(2)

Spare part number

DVD±RW and CD-RW SuperMulti DL Combo Drive

653020-001

Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive

653022-001

DVD-ROM Drive

653019-001

Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive

653021-001

Hard drive
750 GB, 7200 rpm

633252-001

500 GB, 7200 rpm

634925-001

500 GB, 7200 rpm , Self Encrypting hard drive (SED)

683801-001

320 GB, 7200 rpm, 7-mm

634862-001

Hard Drive Hardware Kit (includes hard drive bracket and screws)

644694-001

Solid-state drive (not illustrated)
256 GB SATA III SSD SED

694683-001

180 GB SATA II SSD

694684-001

160 GB SATA II SSD

694685-001

128 GB SATA III SSD

653434-001

Upgrade bay bezel (not illustrated, included in Plastics Kit, spare part number 684794-001)
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Miscellaneous parts
Description

Spare part number

AC adapters
200-W AC adapter

693708-001

150-W AC adapter

693707-001

120-W AC adapter

645156-001

Power cord, 3-pin
For use in Argentina

490371-D01

For use in Australia

490371-011

For use in Brazil

490371-202

For use in Bulgaria

490371-021

For use in Denmark

490371-081

For use in India

490371-D61

For use in Israel

490371-BB1

For use in Japan

490371-291

For use in the People's Republic of China

490371-AA1

For use in South Africa

490371-AR1

For use in South Korea

490371-AD1

For use in Switzerland

490371-111

For use in Taiwan

490371-AB1

For use in Thailand

490371-201

For use in the United Kingdom and Singapore

490371-031

For use in the United States

490371-001

Power cord, 3-prong
For use in Argentina

491683-D01

For use in Asia/Pacific countries and regions

491683-D91

For use in Australia

491683-011

For use in Brazil

491683-202

For use in Denmark

491683-081

For use in Europe, the Middle East, and Africa

491683-021

For use in India

491683-D61

For use in Israel

491683-BB1

Miscellaneous parts
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36

Description

Spare part number

For use in Japan

491683-291

For use in North America

491683-001

For use in the People's Republic of China

491683-AA1

For use in Saudi Arabia

491683-171

For use in South Africa

491683-AR1

For use in South Korea

491683-AD1

For use in Switzerland

491683-111

For use in Taiwan

491683-AB1

For use in Thailand

491683-201

For use in the United Kingdom and Singapore

491683-031

Rubber Kit (includes rubber feet and rubber screw covers)

652663-001

Mouse

390632-001

Optical travel mouse

434594-001

Notebook combination lock

591699-001

Case, professional slim top load

592923-001

Screw Kit

652661-001
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Sequential part number listing
Spare part
number

Description

390632-001

Mouse

434594-001

Optical travel mouse

490371-001

Power cord for use in North America (3-pin)

490371-011

Power cord for use in Australia (3-pin)

490371-021

Power cord for use in Europe, the Middle East, and Africa (3-pin)

490371-031

Power cord for use in the United Kingdom and Singapore (3-pin)

490371-081

Power cord for use in Denmark (3-pin)

490371-111

Power cord for use in Switzerland (3-pin)

490371-201

Power cord for use in Thailand (3-pin)

490371-202

Power cord for use in Brazil (3-pin)

490371-291

Power cord for use in Japan (3-pin)

490371-AA1

Power cord for use in the People's Republic of China (3-pin)

490371-AB1

Power cord for use in Taiwan (3-pin)

490371-AD1

Power cord for use in South Korea (3-pin)

490371-AR1

Power cord for use in South Africa (3-pin)

490371-BB1

Power cord for use in Israel (3-pin)

490371-D01

Power cord for use in Argentina (3-pin)

490371-D61

Power cord for use in India (3-pin)

490371-D91

Power cord for use in AsiaPacific (3-pin)

491683-001

Power cord for use in North America (3-prong)

491683-011

Power cord for use in Australia (3-prong)

491683-021

Power cord for use in Europe, the Middle East, and Africa (3-prong)

491683-031

Power cord for use in the United Kingdom and Singapore (3-prong)

491683-081

Power cord for use in Denmark (3-prong)

491683-111

Power cord for use in Switzerland (3-prong)

491683-171

Power cord for use in Saudi Arabia (3-prong)

491683-201

Power cord for use in Thailand (3-prong)

491683-202

Power cord for use in Brazil (3-prong)

491683-291

Power cord for use in Japan (3-prong)

491683-AA1

Power cord for use in the People's Republic of China (3-prong)

Sequential part number listing
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38

Spare part
number

Description

491683-AB1

Power cord for use in Taiwan (3-prong)

491683-AD1

Power cord for use in South Korea (3-prong)

491683-AR1

Power cord for use in South Africa (3-prong)

491683-BB1

Power cord for use in Israel (3-prong)

491683-D01

Power cord for use in Argentina (3-prong)

491683-D61

Power cord for use in India (3-prong)

491683-D91

Power cord for use in Asia Pacific (3-prong)

572511-001

Intel Centrino Ultimate-N 6300 802.11 3x3 a/g/n WiFi Adapter

591699-001

Notebook combination lock

592923-001

Case, professional slim top load

626729-002

HP Keyed cable lock

628824-001

56k v.92 MDC data/fax modem module

631954-001

Intel Centrino Advanced N 6205, 2x2 a/b/g/n WiFi Adapter

632425-001

8-cell, 2.8-Ah (75-Wh) Li-ion battery

632427-001

8-cell, 2.8-Ah (83-Wh) Li-ion battery

633252-001

750 GB, 7200 rpm hard drive (includes hard drive bracket and screws)

634087-001

9-cell, 3.0-Ah (100-Wh) Li-ion ultra-capacity extended life battery

634089-001

9-cell, 2.8-Ah (73-Wh) Li-ion extended life battery

634400-001

HP un2430 EV-DO/HSPA Mobile Broadband Module

634862-001

320 GB, 7200 rpm hard drive (includes hard drive bracket and screws)

634925-001

500 GB, 7200 rpm hard drive (includes hard drive bracket and screws)

641369-001

4 GB PC3-12800, 1600 MHz, DDR3

644694-001

Hard Drive Hardware Kit

647600-001

Board, MIC B series

652646-001

Display hinges (includes left and right hinges)

652647-001

Display latch with hook

652648-001

Service door

652650-001

RTC battery

652657-001

Display hinge cover (includes Hewlett Packard logo)

652661-001

Screw Kit

652663-001

Rubber Kit (includes rubber feet and rubber screw covers)

652666-001

HP Logo Kit (includes cables)
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Spare part
number

Description

652669-001

Speakers

652672-001

Smart card reader (includes door and cable)

652684-001

Pointing stick cover

652685-001

PCH thermal material

652687-001

Smart card bracket

652972-001

2 GB PC3-12800, 1600 MHz, DDR3

655547-001

Drive upgrade bay

655792-001

HP Integrated Module with Bluetooth 2.1 Wireless Technology

668969-001

HP hs2350 HSPA+ Mobile Broadband Module

669832-001

Broadcom 43228 802.11a/b/g/n 2x2 Wi-Fi Adapter

670034-001

8 GB PC3-12800, 1600 MHz, DDR3

675791-001

HP lt2522 LTE/EV-DO Mobile Broadband Module

675793-001

HP lt2523 LTE/HSPA+ Mobile Broadband Module

680646-002

i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), quad-core processor 1600 MHz, 6MB L3 Cache, 8
threads, 45W

681283-002

i7-3720QM, 2.60GHz (Turbo up to 3.60 GHz), quad-core processor, 1600 MHz, 6 MB L3 Cache, 8
threads, 45W

681284-002

i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), quad-core processor, 1600 MHz, 8 MB L3 Cache, 8
threads, 45W

681952-002

i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), dual-core processor, 1600 MHz, 3 MB L3 Cache, 4 threads,
35W

681953-002

i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), dual-core processor,1600 MHz, 3 MB L3 Cache, 4 threads,
35W

681954-002

i7-3520M, 2.90GHz (Turbo up to 3.60 GHz), dual-core processor, 1600 MHz, 4MB L3 Cache, 4 threads,
35W

683801-001

500 GB, 7200 rpm , Self Encrypting hard drive (SED)

684793-001

ExpressCard/54 slot

684794-001

Plastics kit

690621-001

Display bezel for use on computer models with a webcam

690622-001

Display bezel for use on computer models without a webcam

690623-001

Cable kit

690624-001

LCD cable kit

690626-001

39.6 cm (15.6 in) FHD AG RGB LED UWVA Dream Color with webcam

690627-001

39.6 cm (15.6 in) FHD AG RGB LED UWVA Dream Color
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690628-001

Fan and heat sink assembly for use in computers with AMD FirePro M4000 graphics cards

690629-001

Fan and heat sink assembly for use in computers with NVIDIA Quadro K1000M graphics cards

690630-001

Fan and heat sink assembly for use in computers with NVIDIA Quadro K2000M graphics cards

690631-001

Integrated fingerprint reader

690632-001

Raw Panel Support Kit

690633-001

Battery Latch Kit

690634-001

Power button board

690635-001

Function button board

690636-001

Audio/USB 3.0 board

690637-001

NVIDIA Quadro K2000M (NVIDIA N14P-Q3 2GB DDR3) graphics card

690638-001

NVIDIA Quadro K1000M (NVIDIA N14P-Q1 2GB DDR3) graphics card

690639-001

AMD FirePro M4000 (Chelsea XT GL 1GB GDDR5) graphics card

690640-001

VGA (Dsub 15-pin) port

690641-001

I/O board

690642-001

System board (includes replacement thermal material and VGA support bracket) for use with dual-core
processors and the Windows 7 operating system in all countries except China and Russia

690642-501

System board (includes replacement thermal material and VGA support bracket) for use with dual-core
processors and the Windows 8 Standard operating system in all countries except China and Russia

690642-601

System board (includes replacement thermal material and VGA support bracket) for use with dual-core
processors and the Windows 8 Professional operating system in all countries except China and Russia

690643-001

System board (includes replacement thermal material and VGA support bracket) for use with quad-core
processors and the Windows 7 operating system in all countries except China and Russia

690643-501

System board (includes replacement thermal material and VGA support bracket) for use with quad-core
processors and the Windows 8 Standard operating system in all countries except China and Russia

690643-601

System board (includes replacement thermal material and VGA support bracket) for use with quad-core
processors and the Windows 8 Professional operating system in all countries except China and Russia

690644-001

39.6 cm (15.6 in) High-Definition Plus (HD+) AntiGlare (AG) LED WVA

690645-001

Top cover (includes TouchPad button and bracket)

690647-001

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in the United States

690647-031

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in the United Kingdom and Singapore

690647-041

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Germany

690647-051

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in France
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690647-061

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Italy

690647-081

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Denmark

690647-091

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Norway

690647-161

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Latin America

690647-251

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Russia

690647-281

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Thailand

690647-A41

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Belgium

690647-AB1

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Taiwan

690647-AD1

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in South Korea

690647-B31

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in the Netherlands

690647-B71

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use in only on
computer models equipped with the Windows 7 operating system Sweden and Finland

690647-BG1

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Switzerland

690647-D61

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in India

690647-DB1

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in Canada

690647-FL1

Full-size backlit keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer
models equipped with the Windows 7 operating system in the Czech Republic and Slovakia

690648-001

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use in only on computer
models equipped with the Windows 7 operating system the United States

690648-031

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use in the only on computer
models equipped with the Windows 7 operating system United Kingdom and Singapore

690648-041

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Germany

690648-051

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in France

690648-061

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Italy
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690648-071

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Spain

690648-081

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Denmark

690648-091

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Norway

690648-131

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Portugal

690648-141

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Turkey

690648-151

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Greece

690648-161

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Latin America

690648-171

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Saudi Arabia

690648-201

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Brazil

690648-211

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Hungary

690648-251

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Russia

690648-261

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Bulgaria

690648-271

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Romania

690648-281

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Thailand

690648-291

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Japan

690648-A41

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Belgium

690648-AB1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Taiwan

690648-AD1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in South Korea

690648-B31

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in the Netherlands

690648-B71

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Sweden and Finland
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690648-BA1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Slovenia

690648-BB1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Israel

690648-BG1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Switzerland

690648-D61

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in India

690648-DB1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Canada

690648-DD1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Iceland

690648-FL1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in the Czech Republic and Slovakia

690648-FP1

Full-size keyboard with separate numeric keypad and TouchPad scroll zone for use only on computer models
equipped with the Windows 7 operating system in Northwest Africa

693707-001

150W SLIM Smart AC Adapter

693708-001

200W SLIM Smart AC Adapter

693709-001

120W SLIM Smart AC Adapter

694681-001

39.6 cm (15.6 in) FHD AG LED WVA

694682-001

24 GB flash cache

694683-001

6.35 cm (2.5 in) SATA III solid-state 256 GB Self Encrypting Drive

694684-001

6.35 cm (2.5 in) SATA III solid-state 180 GB drive

694685-001

6.35 cm (2.5 in) SATA III solid-state 160 GB drive

694686-001

6.35 cm (2.5 in) SATA III solid-state 128 GB drive

694687-001

12.7 mm tray load DVD-ROM Drive

694688-001

12.7 mm tray load DVD±RW and CD-RW SuperMulti Double Layer (DL) Drive

694689-001

12.7 mm tray load Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive

694690-001

12.7 mm tray load Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive

695915-001

Intel Centrino Advanced-N 6205 Combo Adapter

696440-001

System board (includes replacement thermal material and VGA support bracket) for use with dual-core
processors in China and Russia only

696441-001

System board (includes replacement thermal material and VGA support bracket) for use with quad-core
processors in China and Russia only

698588-001

Intel Centrino Ultimate-N 6300 Combo Adapter

698946-001

Base Enclosure
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699687-001

Webcan module

702080-001

HP un2430 EV-DO/HSPA Mini Card

702081-002

Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 6.0-MB L3
cache, 45 W; includes replacement thermal material)

702840-002

Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 6.0-MB L3
cache, 45 W; includes replacement thermal material)

703149-001

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in the United States (includes backlight cable, keyboard cable, and pointing
stick cable)

703149-031

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in the United Kingdom and Singapore (includes backlight cable, keyboard
cable, and pointing stick cable)

703149-041

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Germany (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-051

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in France (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-061

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Italy (includes backlight cable, keyboard cable, and pointing stick cable)

703149-081

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Denmark (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-091

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Norway (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-161

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Latin America (includes backlight cable, keyboard cable, and pointing
stick cable)

703149-251

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Russia (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-281

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Thailand (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-A41

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Belgium (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-AB1

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Taiwan (includes backlight cable, keyboard cable, and pointing stick
cable)
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703149-AD1

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in South Korea (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-B31

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in the Netherlands (includes backlight cable, keyboard cable, and pointing
stick cable)

703149-B71

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Sweden and Finland (includes backlight cable, keyboard cable, and
pointing stick cable)

703149-BG1

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Switzerland (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-D61

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in India (includes backlight cable, keyboard cable, and pointing stick cable)

703149-DB1

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in Canada (includes backlight cable, keyboard cable, and pointing stick
cable)

703149-FL1

Keyboard with backlight, numeric keypad, and pointing stick for use only on computer models equipped with
the Windows 8 operating system in the Czech Republic and Slovakia (includes backlight cable, keyboard
cable and pointing stick cable)

703151-001

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in the United States (includes keyboard cable and pointing stick cable)

703151-031

Keyboard with numeric keypad, and pointing stick for use only on computer models equipped with the
Windows 8 operating system in the United Kingdom and Singapore (includes keyboard cable and pointing
stick cable)

703151-041

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Germany (includes keyboard cable and pointing stick cable)

703151-051

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in France (includes keyboard cable and pointing stick cable)

703151-061

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Italy (includes keyboard cable and pointing stick cable)

703151-071

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Spain (includes keyboard cable and pointing stick cable)

703151-081

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Denmark (includes keyboard cable and pointing stick cable)

703151-091

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Norway (includes keyboard cable and pointing stick cable)

703151-131

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Portugal (includes keyboard cable and pointing stick cable)

703151-141

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Turkey (includes keyboard cable and pointing stick cable)

703151-151

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Greece (includes keyboard cable and pointing stick cable)
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703151-161

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Latin America (includes keyboard cable and pointing stick cable)

703151-171

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Turkey (includes keyboard cable and pointing stick cable)

703151-201

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Brazil (includes keyboard cable and pointing stick cable)

703151-211

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Hungary (includes keyboard cable and pointing stick cable)

703151-251

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Russia (includes keyboard cable and pointing stick cable)

703151-261

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Bulgaria (includes keyboard cable and pointing stick cable)

703151-271

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Romania (includes keyboard cable and pointing stick cable)

703151-281

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Thailand (includes keyboard cable and pointing stick cable)

703151-291

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Japan (includes keyboard cable and pointing stick cable)

703151-A41

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Belgium (includes keyboard cable and pointing stick cable)

703151-AB1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Taiwan (includes keyboard cable and pointing stick cable)

703151-AD1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in South Korea (includes keyboard cable and pointing stick cable)

703151-B31

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in the Netherlands (includes keyboard cable and pointing stick cable)

703151-B71

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Sweden and Finland (includes keyboard cable and pointing stick cable)

703151-BA1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Slovenia (includes keyboard cable and pointing stick cable)

703151-BB1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Israel (includes keyboard cable and pointing stick cable)

703151-BG1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Switzerland (includes keyboard cable and pointing stick cable)

703151-D61

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in India (includes keyboard cable and pointing stick cable)

703151-DB1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Canada (includes keyboard cable and pointing stick cable)

703151-DD1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Iceland (includes keyboard cable and pointing stick cable)
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703151-FL1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in the Czech Republic and Slovakia (includes keyboard cable and pointing stick
cable)

703151-FP1

Keyboard with numeric keypad and pointing stick for use only on computer models equipped with the
Windows 8 operating system in Northwest Africa (includes keyboard cable and pointing stick cable)

703266-002

Intel Quad Core i7-3840QM 2.80-GHz processor (SC turbo up to 3.80-GHz; 1600-MHz FSB, 8.0-MB L3
cache, 45 W; includes replacement thermal material)

705053-001

128-GB SATA III solid-state drive

710789-001

HP hs2350 HSPA+ Mobile Broadband Module

Sequential part number listing
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Removal and replacement
procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Phillips P0 and P1 screwdrivers

●

Torx 8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least 2.5 cm (one inch) of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Preliminary replacement requirements
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Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, and then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event

50

10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Preliminary replacement requirements

51

Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.
IMPORTANT: There are as many as 95 screws and screw locks, in 15 different sizes, that must be
removed, replaced, or loosened when servicing the computer. Make special note of each screw and
screw lock size and location during removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

Item

Description

Function

(1)

Product name

The name affixed to the front of the computer.

(2)

Serial number (s/n)

This is an alphanumeric identifier that is unique to
each product.

(3)

Part number/Product number (p/n)

This number provides specific information about
the product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4)

Warranty period

This number describes the duration of the warranty
period for the computer.
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Battery
Description

Spare part number

8-cell, 83-Wh Li-ion battery

632427-001

8-cell, 75-Wh Li-ion battery

632425-001

9-cell, 73-Wh Li-ion extended life battery

634089-001

9-cell, 100-Wh Li-ion ultra-capacity extended life battery

634087-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the battery:
1.

Turn the computer upside down on a flat surface, with the battery bay toward you.

2.

Slide the battery release latch (1) to release the battery.

3.

Rotate the battery (2) forward, and then remove it from the computer (3) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Display panel (non-DreamColor)
Description

Spare part number

HD+ WVA display panel

690644-001

FHD WVA display panel

694681-001

NOTE: The display panel can be removed separately from the display assembly only on non-Dream
Color Models. .
Before removing the display panel, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

Remove the display panel:
1.

Remove the display bezel:
a.

Position the computer upright on a flat surface with the display panel open.

b.

Remove the two rubber pads (1) that cover the display panel screws.
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c.

Remove the two Torx 8 screws (2) that secure the display bezel to the display enclosure.

d.

Flex the top (1) of the bezel from the inside edge until it disengages from the display back
cover.

e.

Flex the inside edge of the left side and the right side (2) of the bezel until it disengages from
the display back cover.

f.

Flex the bottom (3) of the bezel from the inside edge until it disengages from the display
back cover.

g.

Remove the display bezel from the display back cover (4).
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2.

Remove the six Torx 8 screws (1) that secure the display panel to the display enclosure (2).

3.

Disengage the display panel from the base enclosure by closing the display enclosure to 45
degrees while holding the sides of the display panel.
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4.

Remove the two pieces of tape (1) and (2) that secure cables to the back of the display panel.
Carefully disconnect the cable from the connector.

5.

Remove the eight Phillips screws (1) that secure the display panel to the display hinges (four on
either side).

6.

Remove the display panel (2).

Reverse this procedure to install the display panel.
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SIM
NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.
Before removing the SIM, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

Remove the SIM:
1.

Inside the battery bay, press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2.

Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Service door
Description

Spare part number

Service door

652648-001

Before removing the service door, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

Remove the service door:
1.

Position the computer upside down, with the back of the computer toward you.

2.

Slide the service door release latch to the left (1), revealing the service door securing screw (if
present). Remove this screw (2).
NOTE: There is a threaded receptacle on the inside of the service door for stowing this screw.

3.
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While sliding the service door release latch fully to the left (3), slide the service door away from
you (4).
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4.

Remove the service door (5).
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Memory Modules (under service door)
NOTE: A computer having a system board with spare part number 690643-001 or 696441-001 has
four memory slots. In this case, the primary memory is located under the keyboard and expansion
memory is located under the service door.
A computer having a system board with spare part number 690642-001 or 696440-001 has two
memory module slots. In this case, the primary memory is located under the service door.
To access memory modules under the keyboard, see Memory Modules (under keyboard)
on page 85.
Description

Spare part number

8 GB (DDR3 1600MHz PC3-12800)

670034-001

4 GB (DDR3 1600MHz PC3-12800)

641369-001

2 GB (DDR3 1600MHz PC3-12800)

652972-001

Before removing a memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

Remove the memory module:

62

1.

Position the computer upside down, with the front toward you.

2.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3.

Remove the memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.
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RTC battery
Description

Spare part number

RTC battery

652650-001

Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

Remove the RTC battery:
1.

Position the computer upside down, with the front toward you.

2.

Disconnect the RTC battery cable (1) from the system board.

3.

Gently pull the battery (2) from the double-sided tape that secures it to the system board and
remove it from the computer.

Reverse this procedure to install the RTC battery.
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.
Description

Spare part number

Broadcom 43228 802.11 a/b/g/n Wi-Fi 2×2 Adapter

669832-001

Intel Centrino Advanced N 6205 802.11 a/b/g/n 2×2 WiFi Adapter

631954-001

Intel Centrino Advanced-N 6205 Combo Adapter

695915-001

Intel Centrino Ultimate-N 6300 802.11 a/b/g/n 3×3 WiFi Adapter

572511-001

Intel Centrino Ultimate-N 6300 Combo Adapter

698588-001

Before removing the WLAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

Remove the WLAN module:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Position the computer upside down, with the front toward you.
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2.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The WLAN antenna cable marked with [1] is connected to the WLAN module “Main”
terminal. The WLAN antenna cable marked with [2] is connected to the WLAN module “Aux”
terminal. If the computer is equipped with an 802.11 a/b/g/n WLAN module, the WLAN
antenna cable marked with [3] is connected to the middle terminal on the WLAN module.

3.
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Remove the two Phillips screws (2) that secure the WLAN module to the computer. (The edge of
the module opposite the slot rises away from the computer.)
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4.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.
Reverse this procedure to install the WLAN module.
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WWAN module
CAUTION: The WWAN module and the WLAN module are not interchangeable.
Description

Spare part number

HP hs2350 HSPA+ Mobile Broadband Module

668969-001

HP lt2523 LTE/HSPA+ Mobile Broadband Module

675793-001

HP lt2522 LTE/EV-DO Mobile Broadband Module

710789-001

HP un2430 EV-DO/HSPA Mini Card

702080-001

HP un2430 EV-DO/HSPA Mobile Broadband Module

634400-001

Before removing the WWAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

Remove the WWAN module:
1.

Position the computer right-side up with front toward you.

2.

Disconnect the WWAN antenna cables (1) and (2) from the terminals on the WWAN module.
NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

3.
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Remove the two Phillips screws (3) that secure the WWAN module to the computer. (The edge of
the module opposite the slot rises away from the computer.)

Chapter 4 Removal and replacement procedures

4.

Remove the WWAN module (4) by pulling the module away from the slot at an angle.
NOTE: WWAN modules are designed with a notch (5) to prevent incorrect insertion.

Reverse this procedure to install the WWAN module.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the cable kit, spare part number 690624-001. For information about cable
kit contents, see Cable Kit on page 33.
Description

Spare part number

Bluetooth module

655792-001

Before removing the Bluetooth module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

Remove the Bluetooth module:
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1.

Position the computer upside down, with the front toward you.

2.

Remove the tape from the top of the Bluetooth module (1).

3.

Remove the tape from the Bluetooth cable (2).

4.

Disconnect the Bluetooth cable (3) from the system board.

5.

Disconnect the Bluetooth module cable (4) from the Bluetooth module.
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6.

Remove the Bluetooth module.

Reverse this procedure to install the Bluetooth module.
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Hard drive
Description

Spare part number

750 GB, 7200 rpm hard drive

633252-001

500 GB, 7200 rpm hard drive

634925-001

500 GB, 7200 rpm , SED hard drive

683801-001

320 GB, 7200 rpm hard drive

634862-001

256 GB SATA III SED SSD

694683-001

180 GB SATA II SSD

694684-001

160 GB SATA II SSD

694685-001

128 GB SATA III SSD

653434-001

128 GB SATA III SSD locked

705053-001

Hard Drive Hardware Kit (includes hard drive bracket and screws)

644694-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

Remove the hard drive:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
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1.

Position the computer upside down, with the front toward you.

2.

Remove the tape from the top of the smart card reader door (1).
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3.

Loosen the two Phillips captive screws (2) that secure the smart card reader door to the computer.

4.

Open the smart card reader door until it rests on its hinges (1).

5.

Remove three Phillips spring-loaded screws (2) that secure the hard drive to the computer.

6.

Grasp the tab on the hard drive, pull the hard drive to the left (3), and remove the hard drive (4)
from the hard drive bay.

7.

If it is necessary to replace the hard drive bracket, remove the four Phillips hard drive bracket
screws (1) from the sides of the hard drive.
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8.

Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Smart card reader
Description

Spare part number

Smart card reader (includes door and cable)

652672-001

Before removing the smart card reader, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the hard drive (see Hard drive on page 72).

Remove the smart card reader:
1.

If you need to replace the smart card reader door, close the door (1).

2.

Open the zero insertion force (ZIF) connector for the smart card reader cable (2) and then
disconnect the cable from the system board (3).
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3.

Reopen the door, tilt the door towards you (1), and then lift the smart card reader door straight up
from the computer (2).

4.

If it is necessary to replace the smart card reader, remove the two Phillips screws (1) that secure
the smart card reader to the smart card reader door.

5.

Slide the smart card reader out of the smart card reader door (2) while allowing the cable to slide
out of the door guide (3).

Reverse this procedure to reassemble and install the smart card reader.
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Upgrade bay device
Optical drive
NOTE: Computer models may be equipped with an optical drive or an upgrade bay hard drive.
All optical drive spare part kits include an optical drive bezel.
To remove the optical drive, see below.
To remove the upgrade bay hard drive, see following section.
Description

Spare part number

DVD-ROM Drive

694687-001

DVD±RW and CD-RW SuperMulti DL Combo Drive

694688-001

Blu-ray Disc ROM DVD±RW SuperMulti DL Combo Drive

694689-001

Blu-ray Disc R/RE DVD±RW SuperMulti DL Drive

694690-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

Remove the optical drive:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Position the computer upside down with the front side toward you.

2.

Remove the Phillips locking screw (1) that secures the optical drive to the computer.

3.

Insert a small tool (2) into the drive release opening and press the optical drive tab to the left.
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4.

Remove the optical drive (3) from the computer.

5.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear toward
you.

6.

Remove the three Phillips screws (1) that secure the optical drive bracket to the optical drive.

7.

Remove the optical drive bracket (2).

Reverse this procedure to install an optical drive.
Upgrade bay hard drive
Description

Spare part number

Upgrade bay bezel

655547-001

Before removing the upgrade bay hard drive, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

Remove the upgrade bay hard drive:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Position the computer upside down with the front side toward you.

2.

Remove the four Phillips screws securing the hard drive.

3.

Remove the Phillips locking screw (1) that secures the upgrade bay bezel to the computer.

4.

Insert a small tool (2) into the drive release opening and press the upgrade bay bezel tab to the
left.

5.

Remove the upgrade bay bezel (3) from the computer.
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6.

If it is necessary to remove the hard drive, position the upgrade bay bezel with the front toward
you.

7.

Loosen the two captive screws (1) that secure the hard drive to the bezel.

8.

Lift the hard drive connector end up (2). Lift the hard drive out at an angle (3).

Reverse this procedure to install a hard drive in the upgrade bay.
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Keyboard
NOTE: The keyboard spare part kit includes a keyboard cable, numeric keypad, pointing stick, and
pointing stick cable.
For use in country/region

Spare part
number

For use in country/region

Spare part
number

Keyboard with backlight for use only on computer models
equipped with the Windows 8 operating system (includes
backlight cable):

For use in the Netherlands

703149-B31

For use in Belgium

703149-A41

For use in Norway

703149-091

For use in Canada

703149-DB1

For use in Russia

703149-251

For use in the Czech Republic
and Slovakia

703149-FL1

For use in South Korea

703149-AD1

For use in Denmark

703149-081

For use in Sweden and Finland

703149-B71

For use in France

703149-051

For use in Switzerland

703149-BG1

For use in Germany

703149-041

For use in Taiwan

703149-AB1

For use in India

703149-D61

For use in Thailand

703149-281

For use in Italy

703149-061

For use in the United Kingdom
and Singapore

703149-031

For use in Latin America

703149-161

For use in the United States

703149-001

Keyboard without backlight for use only on computer models
equipped with the Windows 8 operating system:

For use in the Netherlands

703151-B31

For use in Belgium

703151-A41

For use in Norway

703151-091

For use in Brazil

703151-201

For use in Northwest Africa

703151-FP1

For use in Bulgaria

703151-261

For use in Portugal

703151-131

For use in Canada

703151-DB1

For use in Romania

703151-271

For use in the Czech Republic
and Slovakia

703151-FL1

For use in Russia

703151-251

For use in Denmark

703151-081

For use in Saudi Arabia

703151-171

For use in France

703151-051

For use in Slovenia

703151-BA1

For use in Germany

703151-041

For use in South Korea

703151-AD1

For use in Greece

703151-151

For use in Spain

703151-071

For use in Hungary

703151-211

For use in Sweden and Finland

703151-B71

For use in Iceland

703151-DD1

For use in Switzerland

703151-BG1

For use in India

703151-D61

For use in Taiwan

703151-AB1

For use in Israel

703151-BB1

For use in Thailand

703151-281

For use in Italy

703151-061

For use in Turkey

703151-141

Component replacement procedures

81

82

For use in country/region

Spare part
number

For use in country/region

Spare part
number

For use in Japan

703151-291

For use in the United Kingdom
and Singapore

703151-031

For use in Latin America

703151-161

For use in the United States

703151-001

Keyboard with backlight for use only on computer models
equipped with the Windows 7 operating system (includes
backlight cable):

For use in the Netherlands

690647-B31

For use in Belgium

690647-A41

For use in Norway

690647-091

For use in the Canada

690647-DB1

For use in Russia

690647-251

For use in the Czech Republic
and Slovakia

690647-FL1

For use in South Korea

690647-AD1

For use in Denmark

690647-081

For use in Sweden and Finland

690647-B71

For use in France

690647-051

For use in Switzerland

690647-BG1

For use in Germany

690647-041

For use in Taiwan

690647-AB1

For use in India

690647-D61

For use in Thailand

690647-281

For use in Italy

690647-061

For use in the United Kingdom
and Singapore

690647-031

For use in Latin America

690647-161

For use in the United States

690647-001

Keyboard without backlight for use only on computer models
equipped with the Windows 7 operating system:

For use in the Netherlands

690648-B31

For use in Belgium

690648-A41

For use in Norway

690648-091

For use in Brazil

690648-201

For use in Northwest Africa

690648-FP1

For use in Bulgaria

690648-261

For use in Portugal

690648-131

For use in Canada

690648-DB1

For use in Romania

690648-271

For use in the Czech Republic
and Slovakia

690648-FL1

For use in Russia

690648-251

For use in Denmark

690648-081

For use in Saudi Arabia

690648-171

For use in France

690648-051

For use in Slovenia

690648-BA1

For use in Germany

690648-041

For use in South Korea

690648-AD1

For use in Greece

690648-151

For use in Spain

690648-071

For use in Hungary

690648-211

For use in Sweden and Finland

690648-B71

For use in Iceland

690648-DD1

For use in Switzerland

690648-BG1

For use in India

690648-D61

For use in Taiwan

690648-AB1

For use in Israel

690648-BB1

For use in Thailand

690648-281

For use in Italy

690648-061

For use in Turkey

690648-141
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For use in country/region

Spare part
number

For use in country/region

Spare part
number

For use in Japan

690648-291

For use in the United Kingdom
and Singapore

690648-031

For use in Latin America

690648-161

For use in the United States

690648-001

Before removing the keyboard, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the Upgrade bay device (see Upgrade bay device on page 77)

Remove the keyboard:
1.

Turn the computer upside down, with the front toward you.

2.

Loosen the three Phillips captive spring-loaded screws that secure the keyboard to the computer.

3.

Open the computer and turn it on its side.
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4.

Insert a small, blunt tool into the release hole, and press on the keyboard until it disengages from
the base enclosure.
NOTE: The center of the keyboard is the release point. If the keyboard does not easily
disengage, press on the keyboard through the opening in the upgrade bay area.

5.

Turn the opened computer right-side up, with the front toward you.

6.

Lift the rear edge of the keyboard and then rotate the keyboard (3) forward until it rests upside
down on top of the TouchPad.

NOTE: If you are accessing the memory modules below the keyboard, it is not necessary to
remove the cables or keyboard.
7.
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Release the ZIF connector for the pointing stick cable (1) and then disconnect the cable from the
system board (2).
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8.

Release the ZIF connector for the keyboard cable (3), and then disconnect the cable from the
system board (4).

9.

If so equipped, release the ZIF connector for the keyboard backlight cable (5) and then
disconnect the cable from the system board (6).

10. Remove the keyboard.
Reverse this procedure to install the keyboard.

Memory Modules (under keyboard)
NOTE: A computer having a system board with spare part number 690643-001 or 696441-001 has
four memory slots. In this case, the primary memory is located under the keyboard and expansion
memory is located under the service door.
A computer having a system board with spare part number 690642-001 or 696440-001 has two
memory module slots. In this case, the primary memory is located under the service door.
To access memory modules under the service door, see Memory Modules (under service door)
on page 62
Description

Spare part number

8 GB (DDR3 1600MHz PC3-12800)

670034-001

4 GB (DDR3 1600MHz PC3-12800)

641369-001

2 GB (DDR3 1600MHz PC3-12800)

652972-001
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Before removing a memory module, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Upgrade bay device (see Upgrade bay device on page 77).

b.

Keyboard (see Keyboard on page 81).

Remove the memory module:
1.

Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2.

Remove the memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install memory module.
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Top cover
The top covers include TouchPad button and bracket.
Description

Spare part number

For use on computer models with a fingerprint reader

652652-001

Before removing the top cover, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

Remove the top cover:
1.

Turn the computer right-side up.

2.

Release the following ZIF connectors (1) and disconnect the corresponding cables (2) from the
system board:
●

Power button ZIF connector

●

TouchPad ZIF cable

●

TouchPad buttons ZIF cable

●

Fingerprint reader ZIF cable

●

Application buttons ZIF cable
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3.
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Remove the following screws that secure the top cover to the base enclosure:
●

Three Phillips screws from the Upgrade bay (1).

●

Three Torx 8 screws in the hard drive bay and four Torx 8 screws in the battery bay (2).

●

Five Torx 8 screws from the front edge and middle of the computer (3).
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4.

Pull up the back edge (1) of the top cover, and then lift the cover (2) away at an angle.

Reverse this procedure to install the top cover.
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Power button board
Description

Spare part number

Power button board

690634-001

Before removing the power button board, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the power button board:
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1.

Position the top cover upside down, with the front toward you.

2.

Remove the two pieces of tape from the top of the power button board (1).

3.

Release the ZIF connector (2) for the power button board cable and then disconnect the cable (3).
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4.

Remove the two Torx 8 screws (4) that secure the power button board to the top cover and then
remove the power button board (5).

Reverse this procedure to install the power button board.
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Function button board
Description

Spare part number

Function button board (includes cable)

690635-001

Before removing the function button board, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the function button board:
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1.

Position the top cover upside down, with the front toward you.

2.

Remove the tape (1) from the top of the function button board.

3.

Remove the two Torx 8 screws (2) that secure the function button board to the top cover.

4.

Lift the function button board (3) from the top cover.
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5.

Disconnect the function button board cable (4) from the function button board.

Reverse this procedure to install the function button board.
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Fingerprint reader board
Description

Spare part number

Fingerprint reader board (includes bracket)

690631-001

Before removing the fingerprint reader board, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the fingerprint reader board:
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1.

Position the top cover upside down, with the front toward you.

2.

Remove the Phillips screw (1) that secures the fingerprint reader board to the top cover.

3.

Remove the fingerprint reader board bracket (2) from the fingerprint reader board.
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4.

Lift the fingerprint reader board (3) from the top cover.

Reverse this procedure to install the fingerprint reader board.
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TouchPad button board
Description

Spare part number

TouchPad button board (included with top cover, spare part number 652652-001)

Before removing the TouchPad button board, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the TouchPad button board:
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1.

Position the top cover upside down, with the front toward you.

2.

Release the ZIF connector (1) for the TouchPad button board cable and then disconnect the cable
(2).

3.

Remove the four Torx 8 screws (3) that secure the TouchPad button board to the top cover.
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4.

Lift the TouchPad button board (4) from the top cover.

Reverse this procedure to install the TouchPad button board.
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VGA port board
Description

Spare part number

VGA port board

690641-001

Before removing the VGA port board, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the VGA port board:
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1.

Position the computer right-side up with the front toward you.

2.

Remove the Phillips screw (1) that secures the VGA port board to the base enclosure.

3.

Remove the two Torx 8 screws (2) that secure the VGA port board to the base enclosure.
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4.

Lift and remove the VGA port board from the base enclosure.

Reverse this procedure to install the VGA port board.
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Fan and heat sink assembly
Description

Spare part number

Fan and heat sink assembly for use in computers with AMD FirePro M4000 graphics cards

690628-001

Fan and heat sink assembly for use in computers with NVIDIA Quadro K2000M graphics cards

690630-001

Fan and heat sink assembly for use in computers with NVIDIA Quadro K1000M graphics cards

690629-001

Before removing the fan and heat sink assembly, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the fan and heat sink assembly:
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1.

Position the computer right-side up, with the front toward you.

2.

Disconnect the fan cable (1) from the system board.

3.

Loosen the eight captive screws (2) that secure the video card heat sink to the base enclosure
following the sequence embossed in the heat sinks.
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4.

Lift the fan and heat sink assembly from the base enclosure (3).

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system board (1),
(3), (5), and (7) and the heat sinks (2), (4), (6), and (8), each time the heat sink is removed.
Replacement thermal material is included with all heat sink and system board spare part kits.

Reverse this procedure to install the fan and heat sink assembly.
NOTE: To properly ventilate the computer, allow at least a 7.6 cm (3 in) clearance on the left side of
the computer.
The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Graphics card
NOTE: All graphics card spare part kits include replacement thermal material.
Description

Spare part number

NVIDIA Quadro K2000M (NVIDIA N14P-Q3 2GB DDR3)

690637-001

NVIDIA Quadro K1000M (NVIDIA N14P-Q1 2GB DDR3)

690638-001

AMD FirePro M4000 (Chelsea XT GL 1GB GDDR5)

690639-001

Before removing the graphics card, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60)

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

Remove the graphics card:
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1.

Position the computer right-side up, with the front toward you.

2.

Remove the two Torx 8 screws (1) that secure the graphics card to the computer. (The edge of the
board opposite the graphics card slot rises away from the computer.)
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3.

Remove the graphics card (2) by sliding it away from the slot at an angle.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the system board (1),
(3), (5), and (7) and the heat sinks (2), (4), (6), and (8), each time the heat sink is removed.
Replacement thermal material is included with all heat sink and system board spare part kits.

Reverse this procedure to install the graphics card.
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Processor
NOTE: All processor spare part kits include replacement thermal material.
Description

Spare part number

Intel Quad Core i7-3840QM 2.80-GHz processor (SC turbo up to 3.80-GHz; 1600-MHz FSB, 8.0MB L3 cache, 45 W)

703266-002

i7-3820QM, 2.70 GHz (Turbo up to 3.70 GHz), quad-core processor, 1600 MHz, 8 MB L3
Cache, 8 threads, 45W

681284-002

Intel Quad Core i7-3740QM 2.70-GHz processor (SC turbo up to 3.70-GHz; 1600-MHz FSB, 6.0MB L3 cache, 45 W)

702840-002

i7-3720QM, 2.60GHz (Turbo up to 3.60 GHz), quad-core processor, 1600 MHz, 6 MB L3
Cache, 8 threads, 45W

681283-002

Intel Quad Core i7-3630QM 2.40-GHz processor (SC turbo up to 3.40-GHz; 1600-MHz FSB, 6.0MB L3 cache, 45 W)

702081-002

i7-3610QM, 2.30 GHz (Turbo up to 3.30 GHz), quad-core processor 1600 MHz, 6MB L3 Cache,
8 threads, 45W

680646-002

i7-3520M, 2.90GHz (Turbo up to 3.60 GHz), dual–core processor, 1600 MHz, 4MB L3 Cache, 4
threads, 35W

681954-002

i5-3360M, 2.80 GHz (Turbo up to 3.50 GHz), dual-core processor,1600 MHz, 3 MB L3 Cache, 4
threads, 35W

681953-002

i5-3320M, 2.60 GHz (Turbo up to 3.30 GHz), dual-core processor, 1600 MHz, 3 MB L3 Cache,
4 threads, 35W

681952-002

Before removing the processor, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).
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d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

Remove the processor:
1.

Position the computer right-side up, with the front toward you.

2.

Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3.

Lift the processor (2) straight up and remove it.
NOTE: The gold triangle (3) on the processor must be aligned with the triangle embossed on
the processor slot when you install the processor.

Reverse this procedure to install the processor.
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Audio/USB 3.0 board
Description

Spare part number

Audio/USB 3.0 board (select models only)

690636-001

Before removing the audio/USB 3.0 board, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the audio/USB 3.0 board:
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1.

Turn the computer right-side up, with the front toward you.

2.

Remove the three Torx 8 screws (1) that secure the audio/USB 3.0 board to the system board.
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3.

Disconnect the audio/USB 3.0 board (2) from the system board by lifting it out at an angle.

Reverse this procedure to install the audio/USB 3.0 board.
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Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the cable kit, spare part number 690623-001. For information about cable
kit contents, see Cable Kit on page 33.
Description

Spare part number

56k v.92 MDC data/fax modem module

628824-001

Before removing the modem module, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

Remove the modem module:
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1.

Turn the computer right-side up, with the front toward you.

2.

Disconnect the modem module cable (1) from the system board.

3.

Remove the two Phillips barrel screws (2) that secure the modem module to the system board.
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4.

Disconnect the modem module (3) from the system board by lifting it straight up.

Reverse this procedure to install the modem module.
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Speakers
Description

Spare part number

Speaker kit

652669-001

Before removing the speakers, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

Remove the speakers:
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1.

Position the computer right-side up, with the front toward you.

2.

Remove the display latch:
a.

Remove the spring (1) from the display latch lock.

b.

Remove the three Phillips screws (2) from the display latch lock.

c.

Push down the button (3) in the front right corner of the display latch lock.
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d.

3.

4.

Slide the display latch lock to the left and remove by pulling straight up from the base
enclosure (4).

Remove the display latch spring buttons:
a.

In the lower right corner of the base enclosure, remove the two Torx 8 screws (1) that secure
the display latch spring button to the base enclosure.

b.

Lift the right display latch spring button (2) straight up from the base enclosure.

Remove the tape (1) from the top of the speakers.
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5.

Disconnect the speaker cable (2) from the system board.

6.

Remove the four Torx 8 screws (3) that secure the speakers to the base enclosure.

7.

Remove the speakers (4) from the base enclosure.

Reverse this procedure to install the speakers.
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ExpressCard/USB 2.0 assembly
Description

Spare part number

ExpressCard/USB 2.0 assembly

652680-001

Before removing the ExpressCard/USB 2.0 assembly, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

f.

Processor (see Processor on page 104).

g.

Modem module (see Modem module on page 108).

h.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

i.

Speakers (see Speakers on page 110).

Remove the ExpressCard/USB 2.0 assembly:
1.

Position the computer right-side up, with the front toward you.

2.

Remove the SD and CFast slot protective inserts (1).

3.

Remove the three Torx 8 screws (2) that secure the assembly to the system board.
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4.

Lift the assembly up (3) and remove the assembly from the base enclosure at a 45 degree angle
(4).

Reverse this procedure to install the ExpressCard/USB 2.0 assembly.
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Northbridge chip heat sink
Description

Spare part number

Northbridge chip heat sink
NOTE: The Northbridge chip heat sink is included with the base enclosure assembly, spare part
number 698946-001.

Before removing the Northbridge chip heat sink, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the Northbridge chip heat sink:
1.

Position the computer right-side up, with the front toward you.

2.

Remove the two Phillips screws (1) that secure the Northbridge chip heat sink to the system board.

Component replacement procedures

115

3.

Remove the Northbridge chip heat sink from the system board (2).

Reverse this procedure to install the Northbridge chip heat sink.
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System board
NOTE: All system board spare part kits include replacement thermal material and VGA support
bracket.
NOTE: Models that support quad-core processors have four memory slots. Models that support dualcore processors have two memory slots.
Description

Spare part number

For use with quad-core processors and the Windows 8 Professional operating system in all countries
except China and Russia

690643-601

For use with quad-core processors and the Windows 8 Standard operating system in all countries
except China and Russia

690643-501

For use with quad-core processors and the Windows 7 operating system in all countries except
China and Russia

690643-001

For use with quad-core processors in China and Russia only

696441-001

For use with dual-core processors and the Windows 8 Professional operating system in all countries
except China and Russia

690642-601

For use with dual-core processors and the Windows 8 Standard operating system in all countries
except China and Russia

690642-501

For use with dual-core processors and the Windows 7 operating system in all countries except
China and Russia

690642-001

For use with dual-core processors in China and Russia only

696440-001

Before removing the system board, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).
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d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

f.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

g.

Speakers (see Speakers on page 110).

h.

ExpressCard/USB 2.0 assembly (see ExpressCard/USB 2.0 assembly on page 113).

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:
●

Memory modules (see Memory Modules (under service door) on page 62)

●

WLAN module (see WLAN module on page 65)

●

WWAN module (see WWAN module on page 68)

●

Modem module (see Modem module on page 108)

●

Processor (see Processor on page 104)

●

Graphics card (see Graphics card on page 102)

●

Northbridge chip heat sink (see Northbridge chip heat sink on page 115)

Remove the system board:
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1.

Position the computer right-side up, with the front toward you.

2.

Remove the tape (1) that secures the cabling to the system board.

3.

Remove the screws (2) that secure the plastic bracket to the system board, and then remove the
bracket (3).
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4.

Disconnect the power jack (1), the network cable (2), the display cable (3), and the webcam
cable (4).

5.

Remove the Phillips screw (1) that secures the smart card reader to the system board.

6.

Remove the three Torx 8 screws (2) that secure the system board to the base enclosure.

7.

Remove the two Torx 8 screws (3) that secure the system board to the optical drive connector.

8.

Remove the system board (4) from the base enclosure.
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Reverse this procedure to install the system board.

RJ-45 connector cable
NOTE: The RJ-45 connector cable is included in the cable kit, spare part number 690623-001.
Before removing the RJ-45 connector cable, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

f.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

g.

Speakers (see Speakers on page 110).

h.

ExpressCard/USB 2.0 assembly (see ExpressCard/USB 2.0 assembly on page 113).

i.

System board (see System board on page 117).

Remove the RJ-45 connector cable:
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1.

Position the computer right-side up, with the front toward you.

2.

Remove the tape (1) from the top of the RJ-45 connector cable.

3.

Remove the RJ-45 connector cable from the clips and routing channel (2) built into the base
enclosure.
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4.

Remove the RJ-45 connector cable from the base enclosure (3).

Reverse this procedure to install the RJ-45 connector cable.
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Power connector cable
NOTE: The power connector cable is included in the cable kit, spare part number 690623-001.
Before removing the power connector cable, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

f.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

g.

Speakers (see Speakers on page 110).

h.

ExpressCard/USB 2.0 assembly (see ExpressCard/USB 2.0 assembly on page 113).

i.

System board (see System board on page 117).

Remove the power connector cable:
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1.

Position the computer right-side up, with the front toward you.

2.

Remove the tape (1) from the top of the power connector cable.

3.

Lift the power connector cable (2) up from the routing in the rear of the base enclosure.
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4.

Remove the power connector cable from the enclosure (3).

Reverse this procedure to install the power connector cable.
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RJ-11 connector cable
NOTE: The RJ-11 connector cable is included in the cable kit, spare part number 690623-001.
Before removing the RJ-11 connector cable, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

f.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

g.

Speakers (see Speakers on page 110).

h.

ExpressCard/USB 2.0 assembly (see ExpressCard/USB 2.0 assembly on page 113).

i.

System board (see System board on page 117).

Remove the RJ-11 connector cable:
1.
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Position the computer right-side up, with the front toward you.

Chapter 4 Removal and replacement procedures

2.

Remove the RJ-11 connector cable from the clips and routing channel built into the base enclosure.

3.

Remove the RJ-11 connector cable from the base enclosure.

Reverse this procedure to install the RJ-11 connector cable.
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Service door latch
NOTE: The service door latch is included with the battery latch kit , spare part number 690633-001.
Before removing the service door latch, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

f.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

g.

Speakers (see Speakers on page 110).

h.

ExpressCard/USB 2.0 assembly (see ExpressCard/USB 2.0 assembly on page 113).

i.

System board (see System board on page 117).

j.

RJ-11 connector cable (see RJ-11 connector cable on page 124).

Remove the service door latch:
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1.

Position the computer right-side up with the front toward you.

2.

Remove the three Phillips screws (1) that secure the service door latch to the base enclosure.
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3.

Remove the service door latch from the base enclosure (2), ensuring that the spring (3) remains
intact with the service door latch.

Reverse this procedure to install the service door latch.

Component replacement procedures

127

Battery latch
NOTE: The battery latch is included with the battery latch kit , spare part number 690633-001.
Before removing the battery latch, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

Remove the service door (see Service door on page 60).

6.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

e.

Fan and heat sink assembly (see Fan and heat sink assembly on page 100).

f.

Audio/USB 3.0 board (see Audio/USB 3.0 board on page 106).

g.

Speakers (see Speakers on page 110).

h.

ExpressCard/USB 2.0 assembly (see ExpressCard/USB 2.0 assembly on page 113).

i.

System board (see System board on page 117).

j.

RJ-11 connector cable (see RJ-11 connector cable on page 124).

k.

Service door latch (see Service door latch on page 126).

Remove the battery latch:
1.

Position the computer right-side up with the front toward you.
CAUTION: Ensure that the spring (1) remains intact while removing the battery latch.

2.
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Remove the two Phillips screws (2) that secure the battery latch to the base enclosure.
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3.

Remove the battery latch from the base enclosure (3).

Reverse this procedure to install the battery latch.
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Display assembly
Description

Spare part number

39.6-cm (15.6 in) FHD RGB UWVA LCD display assembly with DreamColor:
For use in computer models without webcams

690627-001

For use in computer models with webcams

690626-001

NOTE: It is not necessary to remove the display panel in order to remove the display assembly.
However, for access to the webcam module, WLAN module, or WWAN module, you must remove the
display panel. For display panel removal instructions, see Display panel (non-DreamColor) on page 55
Before removing the display assembly, follow these steps:
IMPORTANT: Make special note of each screw and screw lock size and location during removal
and replacement.
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 54).

5.

(Optional) Remove the display panel (see Display panel (non-DreamColor) on page 55)

6.

Remove the service door (see Service door on page 60)

7.

Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 65)
and the WWAN module (see WWAN module on page 68).

8.

Remove the following components:
a.

Hard drive (see Hard drive on page 72).

b.

Upgrade bay device (see Upgrade bay device on page 77).

c.

Keyboard (see Keyboard on page 81).

d.

Top cover (see Top cover on page 87).

Remove the display assembly:
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1.

Position the computer right side up, with the display closed and the rear toward you.

2.

Remove the four Torx T8M2.5×4.5 screws (1) that secure the display hinge cover to the base
enclosure.
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3.

Lift the display hinge cover (2) straight up and remove it.
The display hinge cover is available using spare part number 652657-001.

4.

Remove the two Torx T8M2.5×4.5 screws that secure the display assembly to the computer.

5.

Position the computer upside down, with the front toward you.
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6.

Remove the WLAN and WWAN antenna cables (1) from the routing tabs (2) in the base
enclosure.

7.

Thread the WLAN and WWAN antenna cables (1) through the hole and then back up
underneath the system board, unhook the antenna cables from the retaining tabs (2).

8.

Remove the four Torx 8 screws (1) from the brackets.

9.

Lift the display cable connector (2) straight up from the system board and carefully release the
display cable from the cable routing slots in the base enclosure.
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10. Lift the display assembly straight up from the base enclosure and remove it.

NOTE: For a hinge-up display assembly replacement, reverse these procedures to reinstall the
display assembly.
11. Remove the display bezel:
a.

Remove the two rubber pads (1) that cover the display panel screws.
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b.

Remove the two Torx 8 screws (2) that secure the display bezel to the display enclosure.

c.

Flex the top (1) of the bezel from the inside edge until it disengages from the display back
cover.

d.

Flex the inside edge of the left side and the right side (2) of the bezel until it disengages from
the display back cover.

e.

Flex the bottom (3) of the bezel from the inside edge until it disengages from the display
back cover.
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f.

Remove the display bezel from the display back cover (4).

g.
12. If it is necessary to remove the cable routing tray, remove the three Phillips screws (1) that secure
the cable routing tray to the display enclosure, then pull the cable routing tray towards you (2).
The cable routing tray is available in the Plastics kit, spare part number 684794-001.
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13. Remove the six Torx 8 screws that secure the display panel to the display enclosure.

14. If it is necessary to replace the display hinges, Remove the eight Phillips screws (1) that secure the
display panel to the display hinges (four on either side). The left and right display hinges are
available using spare part number 652646-001.
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a.

Remove the eight Phillips screws (1) that secure the display panel to the display hinges (four
on either side).

b.

Remove the display hinges (2).
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15. If it is necessary to replace the webcam module from the display enclosure, lift the webcam
module straight up (1), then pull the connector for the webcam cable and disconnect the cable
(2).

16. If it is necessary to replace the webcam cable, release the tape securing the cable to the display
cover (1), and then remove the cable (2).
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17. If it is necessary to replace the WWAN antenna cables, detach the WWAN antenna transceivers
(1) from the adhesive on the back cover, and then release the cables from the clips (2) that secure
the cables to the display back cover.

18. If it is necessary to replace the WLAN antenna cables, detach the WLAN antenna transceivers (1)
from the adhesive on the back cover, and then release the cables from the clips (2) that secure the
cables to the display back cover.

Reverse this procedure to reassemble and install the display assembly.
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5

Computer Setup

Windows 8
Using Computer Setup
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of devices installed, the startup sequence of the
computer, and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.
2.

Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes:
Click the Exit icon in the lower-left corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

●

To save your changes and exit Computer Setup menus:
Click the Save icon in the lower-left corner of the screen, and then follow the on-screen
instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS
Updated versions of the BIOS may be available on the HP website.
Most BIOS updates on the HP website are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.
Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed by pressing fn
+esc (if you are already in Windows) or by using Computer Setup.
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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Downloading a BIOS update
CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation, download
and install a BIOS update only when the computer is connected to reliable external power using the AC
adapter. Do not download or install a BIOS update while the computer is running on battery power,
docked in an optional docking device, or connected to an optional power source. During the
download and installation, follow these instructions:
Do not disconnect power on the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Sleep.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
1.

From the Start screen, type h, and then select Help and Support.

2.

In the Help and Support search box, type maintain, and then follow the on-screen
instructions to identify your computer and access the BIOS update you want to download.

3.

At the download area, follow these steps:
a.

Identify the BIOS update that is later than the BIOS version currently installed on your
computer. Make a note of the date, name, or other identifier. You may need this information
to locate the update later, after it has been downloaded to your hard drive.

b.

Follow the on-screen instructions to download your selection to the hard drive.
Make a note of the path to the location on your hard drive where the BIOS update is
downloaded. You will need to access this path when you are ready to install the update.
NOTE: If you connect your computer to a network, consult the network administrator before
installing any software updates, especially system BIOS updates.

BIOS installation procedures vary. Follow any instructions that are displayed on the screen after the
download is complete. If no instructions are displayed, follow these steps:
1.

From the Start screen, type e, and then click File Explorer.

2.

Double-click your hard drive designation. The hard drive designation is typically Local Disk (C:).

3.

Using the hard drive path you recorded earlier, open the folder on your hard drive that contains
the update.

4.

Double-click the file that has an .exe extension (for example, filename.exe).
The BIOS installation begins.

5.

Complete the installation by following the on-screen instructions.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:
●

System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

●

Start-up test—This test analyzes the main computer components that are required to start
the computer.

●

Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

●

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

●

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

●

Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact HP support to report the issue and purchase a
replacement battery.

●

BIOS Management—You can update or rollback the version of the BIOS on the system. Do not
shut down or remove external power during the process. You will be given a confirmation screen
before your BIOS is modified. Select BIOS update, BIOS Rollback, or Back to
main menu.

You can view system information and error logs or select languages in the Advanced System
Diagnostics window.
To start Advanced System Diagnostics:
1.

Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: NOTE: you need to stop a diagnostics test while it is running, press esc.
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Windows 7
Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.
NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer
Setup only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

Using Computer Setup
Navigating and selecting in Computer Setup
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2.
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Press f10 to enter Computer Setup.
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To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
– or –

●

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE: Restoring defaults will not change the hard drive mode.
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2.

Press f10 to enter Computer Setup.

3.

Use a pointing device or the arrow keys to select File > Restore Defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the
factory settings.
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Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.
Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.
Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version
To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.
BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:
1.

Start Computer Setup.

2.

Use a pointing device or the arrow keys to select File > System Information.

3.

To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update
CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:
Do not disconnect power from the computer by unplugging the power cord from the AC outlet.
Do not shut down the computer or initiate Suspend or Hibernation.
Do not insert, remove, connect, or disconnect any device, cable, or cord.
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1.

Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2.

Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3.

Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.
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4.

Click your specific product from the models listed.

5.

Click the appropriate operating system.

6.

Go to the BIOS section and download the BIOS software package.

7.

Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.

Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:
●

Start-up test—This test analyzes the main computer components that are required to start
the computer.

●

Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

●

Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

●

Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

●

Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

●

System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.
To start Advanced System Diagnostics:
1.

1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2.

Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.
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6

Specifications

Computer specifications
Metric

U.S.

Length

25.1 cm

9.86 in

Width

37.4 cm

14.72 in

Height (at front)

3.4 cm

1.34 in

Weight (equipped with 39.6-cm (15.6-in) HD+ display, NV
Graphics, DVD drive, 1-GB DIMM, 160-GB hard drive,
WLAN module, 8-cell battery)

3.1 kg

6.94 lbs

Dimensions

Input power
Operating voltage

19.5V DC @ 6.15A - 120 W Slim Adapter
19.5V DC @ 7.7A - 150 W Slim Adapter
19.5V DC @ 10.3A - 200 W Slim Adapter

Operating current

4.74 A

Temperature
Operating

5°C to 35°C

41°F to 95°F

Relative humidity
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia)

-15 m to 3,048 m

50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia)

-15 m to 12,192 m

-50 ft to 40,000 ft

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
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Metric

U.S.

Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Nonoperating

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep
rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

39.6-cm (15.6-in) HD+ display specifications
Metric

U.S.

Height

19.4 cm

7.59 in

Width

34.4 cm

13.54 in

Diagonal

39.6 cm

15.6 in

Surface treatment

Anti-glare

Contrast ratio

300:1 (typical)

Refresh rate

60 Hz

Brightness

200 nits (typical)

Dimensions

Pixel resolution
Pitch

0.252 mm

Format

1366 x 768

Configuration

RGB stripe

Backlight

LED

PPI

100 ppi

Viewing angle

30/30/20/10 (Left/Right/Down/Up) (minimum) or
45/45/35/25 (Left/Right/Down/Up) (typical)

39.6-cm (15.6-in) HD+ display specifications
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39.6-cm (15.6-in) FHD display specifications
Metric

U.S.

Height

19.4 cm

7.59 in

Width

34.4 cm

13.54 in

Diagonal

39.6 cm

15.6 in

Surface treatment

Anti-glare

Contrast ratio

300:1 (typical)

Refresh rate

60 Hz

Brightness

220 nits (typical)

Dimensions

Pixel resolution
Pitch

0.179 × 0.179 mm

Format

1920 × 1080

Configuration

RGB stripe

Backlight

White LED

PPI

142 ppi

Viewing angle

60/60/50/50 (Left/Right/Down/Up) (minimum) or
70/70/60/60 (Left/Right/Down/Up) (typical)
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Hard drive specifications
750 GB*

500-GB*

320-GB*

Height

9.5 mm

9.5 mm

9.5 mm

Width

70 mm

70 mm

70 mm

Weight

115 g

115 g

115 g

Interface type

ATA-8, SATA 2.6, 3.0
Gb/s, NCQ

ATA-8, SATA 2.6, 3.0
Gb/s, NCQ

ATA-8, SATA 2.6, 3.0
Gb/s, NCQ

Transfer rate

300 MB/sec

300 MB/sec

300 MB/sec

Security

ATA security

ATA security

ATA security

Single track

1.5 ms

1.5 ms

1.5 ms

Average

11 ms

11 ms

11 ms

Maximum

24 ms

24 ms

24 ms

Logical blocks

1,465,149,168

976,773,168

625,142,448

Disc rotational speed

7200 rpm

7200 rpm

7200 rpm

Dimensions

Seek times (typical read, including setting)

Operating temperature

32° to 140° F (0° to 60° C)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE:

Certain restrictions and exclusions apply. Contact technical support for details.
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Solid state drive specifications
256 GB*

128 GB*

Dimensions
Height

7.0 mm

Width

70 mm

Weight

73 g

Interface type

SATA 3 (6 Gb/s)

Security

ATA security

Performance
Maximum sequential read

Up to 460 MB/s

415 MB/s

Maximum sequential write

Up to 260 MB/s

175 MB/s

Logical blocks

500,118,192

250,069,680

Operating temperature

32° to 158°F (0° to 70°C)

*1 GB = 1 billion bytes when referring to solid state drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE:

152

Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW SuperMulti DL Combo Drive
specifications
Supported Media

Read:

Write:

CD-DA, CD-TEXT, CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD (Photo-CD, CDEXTRA, Portfolio, CD-R, CD-RW), CD-R, CD-RW,
DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18),
DVD-R, DVD-RW, DVD+R, DVD+RW, DVD-RAM

CD-R, CD-RW, DVD+R, DVD+RW,
DVD-R, DVD-RW, DVD-RAM, DVD
+R DL, DVD-R DL

Access time

CD

DVD

Random

<140ms

< 160 ms

Interface

Gen 1 SATA

Max data transfer rate

●

24X CD-ROM

●

8X DVD

●

24X CD-R

●

24X CD-RW

●

8X DVD+R

●

8X DVD+RW

●

8X DVD-R

●

6X DVD-RW

●

6X - DVD+R Dual Layer

●

6X - DVD-R Dual Layer

●

5X DVD-RAM

Transfer mode

UDMA Mode 5

Max Media Capacity (read/
write)

8.5 GB

Transport

Tray Loading

DVD±RW and CD-RW SuperMulti DL Combo Drive specifications
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Blu-ray Disc ROM DVD±RW SuperMulti DL Combo
Drive
Supported Media
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Read:

Write:

CD-DA, , CD-TEXT, CD-ROM, CD-ROM
XA, MIXED MODE CD, CD-I, CD-I
Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW,
DVD-ROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW. DVD-RAM, BD-ROM, BD-R,
BD-RE

CD-R, CD-RW, DVD+R, DVD+R DL, DVD
+RW, DVD-R, DVD-R DL, DVD-RW, DVDRAM

Access time

CD-ROM

DVD_ROM

BD-ROM

Random

<190 ms

< 180ms

<230 ms

Interface

Gen 1 SATA

Max data transfer rate

●

24X CD-ROM

●

8X DVD

●

24X CD-R

●

24X CD-RW

●

8X DVD+R

●

8X DVD+RW

●

8X DVD-R

●

6X DVD-RW

●

6X - DVD+R Dual Layer

●

6X - DVD-R Dual Layer

●

5X DVD-RAM

Transfer mode

UDMA Mode 5

Max Media Capacity (read)

50.0 GB

Max Media Capacity (/write)

8.5 GB

Transport

Tray Loading
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DVD-ROM Drive specifications
Supported Media

CD-DA, CD-TEXT, CD-ROM, CD-ROM XA, MIXED MODE CD, CD-I, CD-I Bridge (PhotoCD, Video CD), Multisession CD (Photo-CD, CD-EXTRA, Portfolio, CD-R, CD-RW), CDR, CD-RW, DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM

Access time

CD

DVD

Random

< 140 ms

< 160 ms

Interface

Gen 1 SATA

Max data transfer rate

●

24X CD-ROM

●

8X DVD

Transfer mode

UDMA Mode 5

Max Media Capacity (read)

8.5 GB

Transport

Tray Loading

DVD-ROM Drive specifications
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7

Backup and recovery

Windows 8
To protect your information, use Windows backup and restore utilities to back up individual files and
folders, back up your entire hard drive, create system repair media (select models only) by using the
installed optical drive (select models only) or an optional external optical drive, or create system restore
points. In case of system failure, you can use the backup files to restore the contents of your computer.
From the Start screen, type restore, click Settings, and then select from the list of displayed options.
NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.
In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type h, and then select Help and Support.

Backing up your information
Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. As you add new software and data files, you should continue to back up your system
on a regular basis to maintain a reasonably current backup. The system repair media (select models
only) are used to start up (boot) the computer and repair the operating system in case of system
instability or failure. Your initial and subsequent backups allow you to restore your data and settings if
a failure occurs.
From the Start screen, type backup, click Settings, and then select Save backup copies of your
files with File History.
You can back up your information to an optional external hard drive or a network drive.
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Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.
1.

From the Start screen, type backup, click Settings, and then select from the list of
displayed options.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create system repair media (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created (select models only), you must purchase Windows 8 operating system
media to reboot the computer and repair the operating system. For additional information, see the
“Using Windows 8 operating system media (purchased separately)” section.

Using the Windows recovery tools
To recover information you previously backed up:
▲

From the Start screen, type h, and then select Help and Support.

To recover your information using Startup Repair, follow these steps:

Windows 8
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CAUTION: Some Startup Repair options will completely erase and reformat the hard drive. All files
you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition and the Windows partition.
From the Start screen, type e, and then click File Explorer.
– or –
From the Start screen, type c, and then select Computer.
NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system DVD and the Driver
Recovery media (both purchased separately). For additional information, see the “Using Windows
8 operating system media (purchased separately)” section.

3.

If the Windows partition and the HP Recovery partition are listed, restart the computer. After
Windows has loaded, press and hold the shift key while clicking Restart.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select
Help and Support.

Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: From the Start screen, type c, and
then select Computer.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media and the Driver Recovery media (both
purchased separately). For additional information, see the “Using Windows 8 operating system
media (purchased separately)” section.

3.
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If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.
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4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)
To order a Windows 8 operating system DVD, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the DVD by calling support. For
contact information, see the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 8 operating system DVD:
NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 8 operating system DVD into the optical drive
before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

After the repair is completed:
1.

Eject the Windows 8 operating system media and then insert the Driver Recovery media.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Using Windows Refresh for quick and easy recovery
When your computer is not working properly and you need to regain system stability, the Windows
Refresh option allows you to start fresh and keep what is important to you.
IMPORTANT: Refresh removes any traditional applications that were not originally installed on the
system at the factory.
NOTE: During Refresh, a list of removed traditional applications will be saved so that you have a
quick way to see what you might need to reinstall. See Help and Support for instructions on reinstalling
traditional applications. From the Start screen, type h, and then select Help and Support.
NOTE: You may be prompted for your permission or password when using Refresh. See Windows
Help and Support for more information. From the Start screen, type h, and then select
Help and Support.
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To start Refresh:
1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2.

Click Settings.

3.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4.

Under Refresh your PC without affecting your files, select Get started, and follow the
on-screen instructions.

Remove everything and reinstall Windows
Sometimes you want to perform detailed reformatting of your computer, or you want to remove
personal information before you give away or recycle your computer. The process described in this
section provides a speedy, simple way to return the computer to its original state. This option removes
all personal data, apps, and settings from your computer, and reinstalls Windows.
IMPORTANT: This option does not provide backups of your information. Before using this option,
back up any personal information you wish to retain.
You can initiate this option by using the f11 key or from the Start screen.
To use the f11 key:
1.

Press f11 while the computer boots.
– or –
Press and hold f11 as you press the power button.

2.

Select Troubleshoot from the boot options menu.

3.

Select Reset your PC, and follow the on-screen instructions.

To use the Start screen:
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1.

On the Start screen, point to the far-right upper or lower corner of the screen to display
the charms.

2.

Click Settings.

3.

Click Change PC settings in the bottom-right corner of the screen, and then select General
from the PC settings screen.

4.

Under Remove everything and reinstall Windows, select Get started, and follow the
on-screen instructions.
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Using HP Software Setup
HP Software Setup can be used to reinstall drivers or select software that has been corrupted or deleted
from the system.
1.

From the Start screen, type HP Software Setup, and select Apps.

2.

Open HP Software Setup.

3.

Follow the on-screen directions to reinstall drivers or select software.

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of
your computer.
Windows Backup and Restore provides the following options:
●

Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

●

Backing up your information

●

Creating a system image (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.
In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.

Windows 7
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Creating recovery media with HP Recovery Disc Creator
HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
select drivers and applications if the hard drive becomes corrupted.
HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:
●

Windows DVD—Installs the operating system without additional drivers or applications.

●

Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media
NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.
1.

Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.

Select Driver DVD or Windows DVD.

3.

From the drop-down menu, select the drive for burning the recovery media.

4.

Click the Burn button to start the burning process.

Backing up your information
Recovery after a system failure is as good as your most recent backup. Immediately after setting up the
computer, you should create system repair discs (select models only) using the installed optical drive
(select models only) or an optional external optical drive and back up your system. As you add new
software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
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●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

●

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive you are using.

Chapter 7 Backup and recovery

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.
●

When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select
models only), or create a system repair disc (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see the Using a
Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools
To recover information you previously backed up:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select
models only), or your files.

To recover your information using Startup Repair, follow these steps:
CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the hard
drive. All files you have created and any software installed on the computer are permanently removed.
When reformatting is complete, the recovery process restores the operating system, as well as the
drivers, software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition.
To check for the Windows partition, select Start > Computer.

Windows 7
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3.

If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools
CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.
NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.
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3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11>” for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)
To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact_us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD:
NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.

After the repair is completed:
1.

Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.

Windows 7
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8

Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:
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●

The length of the power cord set must be at least 1.0 m (3.3 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

CCC

5

South Korea

EK

4

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

Requirements for specific countries and regions
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Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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Index

Symbols/Numerics
1394 port, identifying 17
A
AC adapter, spare part number
35
accessory battery connector,
identifying 20
antennas, disconnecting 68
audio, product description 3
audio-in (microphone) jack,
identifying 16
audio-out (headphone) jack,
identifying 16
Audio/USB 3.0 board
spare part number 27
audio/USB 3.0 board
removal 106
spare part number 106
B
base enclosure, spare part
number 29
battery
removal 54
spare part number 29, 38, 54
battery bay, identifying 20
battery cover, illustrated 32
battery latch removal 128
battery light 14
battery release latch 20
Blu-ray Disc R/RE DVD±RW
SuperMulti DL Drive
removal 77
spare part number 30, 34, 77
Blu-ray Disc ROM DVD±RW
SuperMulti DL Combo Drive
removal 77

spare part
694689-001number 30
spare part number 34, 77
specifications 154
Bluetooth cable, illustrated 33
Bluetooth compartment,
identifying 21
Bluetooth module
removal 70
spare part number 29, 70
buttons
calculator 12
center pointing stick 8
center TouchPad 8
left pointing stick 8
left TouchPad 8
optical drive eject 16
power 11
right pointing stick 8
right TouchPad 8
C
Cable Kit
contents 33
spare part number 33
cable kit
spare part number 30
cables, service considerations 49
calculator button, identifying 12
calculator light 10
caps lock light, identifying 10
chipset, product description 1
components
bottom 20
display 19
front 14
left side 17
rear 18

right side 16
top 8
computer specifications 148
connector, power 18
connectors, service
considerations 49
D
diskette drive, precautions 49
display assembly
removal 130
spare part number 24, 130
display bezel
removal 55
spare part number 31
display components, spare part
number 31
display hinges, spare part
number 31, 38
display latch button, illustrated 32
display latch kit, spare part
number 38
display panel
product description 2
removal 55
spare part number 31, 55
display release latch 14
display specifications 149, 150
DisplayPort, identifying 17
docking connector, identifying 20
docking support, product
description 5
drives
preventing damage 49
DVD-ROM Drive
precautions 49
removal 77
spare part number 30, 34, 77
specifications 155

Index
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DVD±RW and CD-RW SuperMulti
DL Combo Drive
precautions 49
removal 77
spare part number 30, 34, 77
E
electrostatic discharge 50
eSATA port 17
esc key, identifying 13
Ethernet, product description 3
ExpressCard blank, illustrated 32
ExpressCard/USB 2.0 assembly
removal 113
spare part number 113
external media cards, product
description 4
external monitor port 16
F
fingerprint reader board
removal 94
spare part number 94
fingerprint reader, identifying 12
fn key, identifying 13
function button board
removal 92
spare part number 92
function keys, identifying 13
G
graphics card
removal 102
spare part number 28, 102
graphics, product description 1
grounding equipment and
methods 52
H
hard drive
precautions 49
product description 3
removal 72
spare part number 34, 38, 72
spare part numbers 30
specifications 151, 152
hard drive bracket, removal 74
hard drive hardware kit, spare part
number 38
hard drive light 14
hard drive, identifying 21
170

Index

headphone (audio-out) jack 16
hinge cover
removal 130
spare part number 29, 131
hinge cover, spare part number
38
hinges, spare part number 31, 38
HP Logo Kit
spare part number 38
HP Logo Kit, spare part number
31
I
integrated numeric keypad,
identifying 13
integrated webcam light,
identifying 19
internal display switch 19
internal microphones, identifying
19
inverter cover, illustrated 32
J
jacks
audio-in (microphone) 16
audio-out (headphone) 16
network 17
RJ-11 (modem) 18
RJ-45 (network) 17
K
keyboard
product description 5
removal 81
spare part number 81
spare part numbers 24, 44,
45, 46, 47
keypad
integrated numeric 13
keys
esc 13
fn 13
function 13
Windows applications 13
Windows logo 13
L
latches, battery release 20
lights
battery 14
calculator 10

caps lock 10
hard drive 14
num lk 10
power 10, 14
TouchPad 10
webcam 19
wireless 10
M
mass storage devices, spare part
number 34
Media Card Reader, identifying
15
memory module
identifying 21
product description 2
spare part number 62, 85
under keyboard
;identifying 62, 85
;removal 62, 85
microphone (audio-in) jack
product description 3
microphone (audio-in) jack,
identifying 16
model name 1
modem module
product description 3
removal 108
spare part number 38, 108
N
network jack, identifying 17
Northbridge chip heat sink
removal 115
num lk light 10
O
operating system, product
description 6
optical drive
precautions 49
product description 3
removal 77
spare part number 30, 34, 77
specifications 153, 154, 155
optical drive eject button,
identifying 16
optical drive weight saver
illustrated 32

P
packing guidelines 51
PCH thermal material
spare part number 39
plastic parts 48
Plastics Kit
contents 32
spare part number 32
pointing device, product
description 5
pointing stick 8
pointing stick cover
spare part number 39
ports
1394 17
DisplayPort 17
external monitor 16
product description 4
USB 17
USB charging 17
power button board
removal 90
spare part number 90
power button, identifying 11
power connector cable
illustrated 33
removal 122
spare part number 122
power connector, identifying 18
power cord
set requirements 166
spare part number 37
spare part numbers 35
power lights 10, 14
power requirements, product
description 5
processor
product description 1
removal 104
spare part number 27, 104
spare part numbers 44
product description
audio 3
chipset 1
display panel 2
docking support 5
Ethernet 3
external media cards 4
graphics 1
hard drives 3

keyboard 5
memory module 2
microphone 3
modem module 3
operating system 6
optical drives 3
pointing devices 5
ports 4
power requirements 5
processors 1
product name 1
security 5
serviceability 7
webcam 3
wireless 4
product name 1
R
removal/replacement
preliminaries 48
procedures 53
RJ-11 (modem) jack
spare part number 27
RJ-11 (modem) jack, identifying
18
RJ-11 connector cable
removal 124
RJ-11 jack cover
illustrated 32
RJ-45 (network) jack, identifying
17
RJ-45 connector cable
removal 120
RTC battery
removal 64
spare part number 38, 64
Rubber Kit, spare part number 38
S
Screw Kit, spare part number 36,
38
SD Card blank, illustrated 32
security cable slot, identifying 17
security, product description 5
service considerations 48
service door 21
removal 60
spare part number 38, 60
service door latch
removal 126

service tag 22, 53
serviceability, product description
7
SIM slot, identifying 20
SIM, removal 59
slots
security cable 17
SIM 20
smart card bracket, spare part
number 39
smart card reader
removal 75
spare part number 39, 75
smart card reader, identifying 16
solid-state drive
spare part numbers 47
solid-state drive, spare part
number 34, 72
solid-state drive, spare part
numbers 30
speakers
removal 110
spare part number 29, 39,
110
specifications
Blu-ray Disc ROM DVD±RW
SuperMulti DL Combo Drive
154
computer 148
display 149, 150
DVD-ROM Drive 155
DVD±RW and CD-RW
SuperMulti DL Combo Drive
153
hard drive 151, 152
optical drive 153, 154, 155
static-shielding materials 52
system board
removal 117
spare part number 28, 117
spare part numbers 40, 47
T
tools required 48
top cover
removal 87
spare part number 27, 87
TouchPad
buttons 8
on/off button 12

Index
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TouchPad button board
removal 96
spare part number 96
TouchPad light, identifying 10
TouchPad zone
identifying 9
transporting guidelines 51
U
upgrade bay 16
upgrade bay bezel, spare part
number 78
upgrade bay hard drive, removal
78
USB 3.0 port 16
USB charging port 17
USB ports, identifying 16, 17
V
vents, identifying 17, 20
VGA port board
removal 98
spare part number 98
W
webcam 19
product description 3
webcam light, identifying 19
webcam module, spare part
number 31
webcam, identifying 19
Windows applications key,
identifying 13
Windows logo key, identifying
13
wireless antennas
disconnecting 66, 68
wireless antennas, identifying 19
wireless light 10
wireless, product description 4
WLAN antennas, identifying 19
WLAN module
removal 65
spare part number 29, 38, 65
spare part numbers 43
workstation guidelines 51
WWAN antennas, identifying 19
WWAN module
removal 68
spare part number 29, 38, 68
spare part numbers 44, 47
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